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HOW TO USE THIS MANUAL 

The purpose of this manual is to describe a typical installation of all components of the ECF (ECCAIRS 5 
Common Framework) system, as well as set-up and configuration of database components for the 
storage of accident/incident Occurrences in a standardised and structured manner. 
To simplify the reading, form now on the term ECCAIRS 5 will be used everywhere, also in place of ECF, 
ECCAIRS 5 Common Framework). 
In fact the ECCAIRS Server and all the ECCAIRS Client applications are based on the ECF layer, but 
this is relevant only from the software developer standpoint, and not for the User or Administrator. 

Start with Chapter 1 

To use the manual you must first read carefully Chapter "1 WHAT TO INSTALL", page 9. 

This will guide you to the suitable Chapters/Sections to read and follow. 
This is very important, since any single Chapter/Section may be useful for one or more or none 
installation type.  

Print and use the forms in Chapter 7 

Before starting any installation print the suitable Configuration Data Summary form. 

Chapter "7 FORMS TO PRINT AND FILL", page 153 provides "Configuration Data Summary" forms for 
all the ECCAIRS 5 installation types illustrated in Chapter "1 WHAT TO INSTALL". 
All the installation options are listed: you should mark the check-boxes of the options chosen for your 
specific installation and write down the corresponding configuration data used. 
These forms are useful both to: 

 Recall data and parameters for subsequent installations. 

 Provide the specific installation and configuration made to get effective system support. 

 

 

 
To help in the "local" navigation of the manual pages, in addition to the Table of Contents on the next 
page, you can also use the page header, which shows: 

 On the left the main chapter. 

 On the right the chapter 1st level sections. 

 

 
The manual also uses cross references with target page numbers indicated and formatted in a specific 
link style for better spotting. 
For instance (see page 32) 
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1. WHAT TO INSTALL 

1.1. INSTALLATION TYPES: CLIENT, SERVER, WEB SERVER 
There are three ECCAIRS 5 software installation types: Client, Server, and Web Server. 

1.1.1. CLIENT 

The Client type of installation provides all the standard ECCAIRS 5 applications (Browser, Grapher, 
Data Manager, etc) that can access data provided by one or more ECCAIRS 5 Servers on different 
Computers over the network. 
If the ECCAIRS 5 Server is to be installed on the same computer of the Client, then you should choose a 
Server installation, which includes both the Server and Client software. 

 
See Section "1.2 Installation options - Client", page 12, for installation options and corresponding 
Roadmaps suited to your specific case. 
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1.1.2. SERVER 

The Server type of installation sets up an ECCAIRS 5 Server system that provides ECCAIRS data to 
networked ECCAIRS 5 Clients, through one or more Repositories. The ECCAIRS 5 Server installation 
contains all the software of the Client version, with the addition of administrative tools and configuration 
files needed for creating ECCAIRS Repositories. 

See page15, Section "1.3 Installation options - Server", for installation options and corresponding 
Roadmaps suited to your specific case. 

A special Server configuration is the Stand-alone Server which gives access the ECCAIRS 5 Server only 
from the ECCAIRS 5 Client applications which are installed on the same COMPUTER. See page15, 
Section "1.3 Installation options - Server", for installation options and corresponding Roadmaps suited to 
this case in Section "1.3.4 Stand-alone Server", page 18. 
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1.1.3. WEB SERVER 

The Web Server type of installation provides, in addition to the standard ECCAIRS 5 Server 
functionality, also a web-based access to the ECCAIRS 5 Server through one of the supported Web 
browsers. 
An ECCAIRS 5 Web Server also includes the functionality of the ECCAIRS 5 Client and Server. 

 

See page 22, Section "1.4 Installation options - Web Server", for installation options and corresponding 
Roadmaps suited to your specific case. 
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1.2. INSTALLATION OPTIONS - CLIENT 

1.2.1. CLIENT OPTIONS AVAILABLE 

There are no special installation options during the installation, but when you configure in the ECCAIRS 
5 Client login the link to a specific Repository on an ECCAIRS 5 Server you may select a number of 
Client-Server communication protocols: 

 Web Services: including Net.TCP, Basic HTTP, Ws HTTP, Basic HTTPS, Ws HTTPS. 
The Web Services access protocols needs to be installed on the Server you are connecting to. 
On the client side, the main advantage on using Web Services protocols is to allow ECCAIRS 5 
Client-Server connection both over LAN and over WAN. This allows to use ECCAIRS over 
Intranet, VPN and Proxy. 

 DCOM (legacy solution) 
DCOM is commonly configured and made available in all network-accessible ECCAIRS 5 
Servers, and is the same and only protocol used in the previous release, ECCAIRS 4. 

There is also a third "Protocol Type" choice: 
 LOCAL SERVER (requires an ECCAIRS 5 Server on the same COMPUTER) 

This is an option that you can only use if you are connecting to an ECCAIRS 5 Server within the 
same computer. This means that you have this option only if you have performed on the 
computer either a Server or a Web Server installation, since both of them install the ECCAIRS 5 
Server and Client software on the same computer. Refer to the ECCAIRS 5 Stand-alone Server 
roadmap for setup details (see page 18). 

 

The diagram illustrates visually the relations among the options discussed above. 

The next sections contain the Client installation roadmaps corresponding to the options mentioned. 
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1.2.2. CLIENT WITH DCOM REMOTE ACCESS TO A SERVER 

 

ECCAIRS 5 Client applications require to login and communicate with a Repository located on an 
ECCAIRS 5 Server. 

When you configure each link to a Repository to be used in the login phase you have to specify the 
communication protocol to use. 

You can link to Repositories using the DCOM protocol. 

The DCOM protocol is normally configured and made available in all network-accessible ECCAIRS 5 
Servers, and is the same and only protocol used in the previous release, ECCAIRS 4. 

Installation roadmap and checklist 

See page 29, Section "2.1.2 Client with DCOM remote connection". 
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1.2.3. CLIENT WITH WEB SERVICES REMOTE ACCESS TO A SERVER 

 

ECCAIRS 5 Client applications require to login and communicate with a Repository located on an 
ECCAIRS 5 Server. 

When you configure each link to a Repository to be used in the login phase you have to specify the 
communication protocol to use. 

You can link to Repositories using Web Services protocols: Net.TCP, Basic HTTP, Ws HTTP, Basic 
HTTPS, Ws HTTPS. The last two options allow to use a secure, encrypted communication protocol. 

The Web Services access protocols needs to be installed on the Server you are connecting to. 

On the client side, the main advantage on using Web Services protocols is to allow ECCAIRS 5 Client-
Server connection both over LAN and over WAN. 

Installation roadmap and checklist 

See page 30, Section "2.1.3 Client with Web Services remote connection". 
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1.3. INSTALLATION OPTIONS - SERVER 
Before going through the installation roadmaps you must know about the installation and configuration 
options that you may choose for an ECCAIRS 5 Server. 

These can be divided into three groups: 

 Mandatory connection configuration options. 

 Other mandatory setups needed to operate the ECCAIRS Server. 

 Optional Server components. 

1.3.1. MANDATORY CONNECTION CONFIGURATION OPTIONS 

These are configurations that you must perform to let the Clients connect to the Server. 

Note that an ECCAIRS 5 Web Server also needs a Client connection to an ECCAIRS 5 Server to work. 
So these Server configurations are needed even when using an ECCAIRS 5 Web Server. 

You may choose to configure one or more of the following connection protocols: 

 NO CONNECTION PROTOCOL (only for Stand-alone Server, even a with a local Web Server) 
This is an option that you can only use if the ECCAIRS 5 Server only allows connections from the 
ECCAIRS 5 Client within the same computer. 
You can also use this option if you have performed a Web Server installation, which also installs 
an ECCAIRS 5 Server on the same computer, and you want only the Web Server or local Client 
software to access the local ECCAIRS 5 Server. 

 DCOM 
DCOM is normally configured and made available in all network-accessible ECCAIRS 5 Servers, 
and is the same and only protocol used in the previous release, ECCAIRS 4. 

 Web Services: including Net.TCP, Basic HTTP, Ws HTTP, Basic HTTPS, Ws HTTPS protocols. 
On the ECCAIRS 5 Server side, Web Services protocols allows better configuration, more 
scalability, less Server resources usage and simpler firewall configuration. It is easier to allow 
ECCAIRS 5 Client-Server connection both over LAN and over WAN. 

Web Services can be provided via two software components: 

 Windows Service, allowing one or more of the following connection protocols: 

o Net.TCP  

o Basic HTTP 

o Ws HTTP 

 IIS, allowing one or more of the following connection protocols: 

o Basic HTTP or (in alternative) Basic HTTPS (the http secure/encrypted version) 

o Ws HTTP or (in alternative) Ws HTTPS (the http secure/encrypted version) 

In addition to the configurations needed for the ECCAIRS 5 Server to provide the connection protocols, 
there will also be corresponding settings to implement on the Windows Firewall software on the 
computer. 

The next Sections illustrate the different installation/configuration roadmaps corresponding to the various 
protocols type and provider. 
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The diagram illustrates visually the relations among the options discussed above. 
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1.3.2. OTHER MANDATORY TASKS NEEDED TO OPERATE THE SERVER 

Once you have performed the ECCAIRS 5 Server installation and configured the connection protocols to 
communicate with Clients, you need to perform a number of other "side" installations and/or 
configurations to be able to operate the Server. 

These steps are related to the specific Taxonomy to use and the Repositories to be deployed on the 
Server: 

 Install an Extension. 

 Setup Occurrence database. 

 Create a Repository. 

See page 89, Section "3.9 Tasks needed to operate the Server" for further details, including a roadmap 
with checklist. 

1.3.3. OPTIONAL SERVER COMPONENTS 

Beyond the basic installation and mandatory configurations, there are some optional Server components 
that you may wish to install: 

 Automatic Backup. 

 Postponed Indexing. 

 Number Generator Add-in. 

 E-Mail Support. 

See page 115, Section "4.1 Additional services available" for further details and instructions. 
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1.3.4. STAND-ALONE SERVER  

 

A stand-alone Server configuration allows the access to the ECCAIRS 5 Server only to the ECCAIRS 5 
Client applications installed inside the same computer. There is no need for network access and 
protocols setup beyond software installation. 

As for all Server installations, you then need to specialise the generic ECCAIRS 5 installation with 
extensions, set up an Occurrence and Attachment database, local or on another computer, and prepare 
the Repository(ies). 

Also you might need to install any of the optional Server components. 

Installation roadmap and checklist 

See page 52, Section "3.1.1 Stand-alone Server roadmap". 
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1.3.5. SERVER WITH DCOM ACCESS 

This Server configuration allows access from network Clients through DCOM protocol. This is the 
configuration and protocol that were available in the previous ECCAIRS 4 version. The configuration also 
specifies and requires suitable settings on the Windows firewall. 

You can also configure the Server to allow other access protocols at the same time. 

As for all Server installations, you then need to specialise the generic ECCAIRS 5 installation with 
extensions, set up an Occurrence and Attachment database, local or on another computer, and prepare 
the Repository(ies). 

Also you might want to install any of the optional Server components. 

Installation roadmap and checklist 

See page 53, Section "3.1.2 Server with DCOM access roadmap". 
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1.3.6. SERVER WITH WEB SERVICES ACCESS VIA WINDOWS SERVICE 

This Server configuration allows access from network Clients through Web Services protocols: Net.TCP, 
Basic HTTP, Ws HTTP, provided via a suitable Windows service. 

In this configuration the Windows service requires its own installation and configuration. The 
configuration also specifies and requires suitable settings on the Windows firewall. 

On the ECCAIRS 5 Server side, Web Services protocols allows better configuration, more scalability, 
less Server resources usage and simpler firewall configuration. It is easier to allow ECCAIRS 5 Client-
Server connection both over LAN and over WAN. 

You can also configure the Server to allow other access protocols (DCOM and Web Services via IIS) at 
the same time. 

As for all Server installations, you then need to specialise the generic ECCAIRS 5 installation with 
extensions, set up an Occurrence and Attachment database, local or on another computer, and prepare 
the Repository(ies). 

Also you might want to install any of the optional Server components. 

Installation roadmap and checklist 

See page 54, Section "3.1.3 Server with Web Services access via Windows service". 
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1.3.7. SERVER WITH WEB SERVICES ACCESS VIA IIS 

This Server configuration allows access from network Clients through Web Services protocols: Basic 
HTTP, Ws HTTP hosted by IIS. 

In this configuration you need to have IIS installed and running, then perform some IIS and ECCAIRS 5 
own configuration. The configuration may also require suitable settings on the Windows own firewall, or 
on any other internal or external firewall in use, if non standard TCP ports are configured. 

On the ECCAIRS 5 Server side, Web Services protocols allows better configuration, more scalability, 
less Server resources usage and simpler firewall configuration. It is easier to allow ECCAIRS 5 Client-
Server connection both over LAN and over WAN. 

You can also configure the Server to allow other access protocols (DCOM and Web Services provided 
by Windows service) at the same time. 

As for all Server installations, you then need to specialise the generic ECCAIRS 5 installation with 
extensions, set up an Occurrence and Attachment database and prepare the Repository(ies). 

Also you might want to install any of the optional Server components. 

Installation roadmap and checklist 

See page 74, Section "3.8 Setup access via Web Services (by IIS)". 
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1.4. INSTALLATION OPTIONS - WEB SERVER 

Before going through the installation roadmaps you must know about the other mandatory installation 
and configuration steps, beyond the ECCAIRS 5 Software own installation, and the options you may 
choose for an ECCAIRS 5 Web Server. These can be divided into two groups: 

 Mandatory setups and configuration. 

 User authentication option. 

The ECCAIRS 5 Web Server needs to communicate with a working and properly configured ECCAIRS 5 
Server. 
Therefore remember that, if you do not have such ECCAIRS 5 Server available yet, you first have to 
perform all the steps foreseen for a Server installation (Section "3 SERVER INSTALLATION", page 51). 
If you want to run a local ECCAIRS 5 Server, on the same computer where you have installed the 
ECCAIRS 5 Web Server, then you have to skip the Server software installation (Section "3.4 Install the 
Server software", page 60), because the Server software is automatically installed when selecting a Web 
Server installation type. 

1.4.1. WEB SERVER SETUPS AND CONFIGURATIONS 

Beyond the ECCAIRS 5 Software own installation you have to mandatorily setup and configure: 

 CONFIGURE IIS FOR ECF 
The ECCAIRS 5 Web Server uses Microsoft IIS to offer Web-based ECCAIRS access. 
You need to perform IIS configuration steps, which are specified both for IIS 6 and IIS 7. 

 CREATE THE WEB SERVER OWN DATABASE 
The ECCAIRS 5 Web Server needs its own database to manage Web Users and sessions. This 
must be created on an Oracle or MS SQL Server RDBMS. 

 DEFINE CONNECTION TO THE WEB SERVER OWN DATABASE 
The ECCAIRS 5 Web Server needs to configure a connection to the Web own database, used to 
manage Web Users and sessions. 

 DEFINE CONNECTIONS WITH SUITABLE REPOSITORIES 
The ECCAIRS 5 Web Server performs a Client connection towards an ECCAIRS 5 Server to 
forward the requests and forward back results to a Web Server User. 
Therefore you have to configure the connection to Repositories on one or more ECCAIRS 5 
Servers that you want to make available to Web Users. In particular you may have: 

o REMOTE REPOSITORIES - DCOM ACCESS. 

o REMOTE REPOSITORIES - WEB SERVICES ACCESS: 

o LOCAL REPOSITORIES - LOCAL ACCESS TO ECCAIRS 5 SERVER. 
A notable and often used configuration is to define connections to Repositories on the 
local ECCAIRS 5 Server, installed on the same computer/Server. 
In this case there is no need to have network access protocols (DCOM, Web Services) on 
the local ECCAIRS 5 Server, unless you want also to allow LAN Clients access at the 
same time. You may perform a Stand-alone ECCAIRS 5 Server simpler configuration. 

In the next Sections we illustrate the three Repository connection types. 

User Authentication option 

If you wish that a Web User, accessing the ECCAIRS 5 Web Server over the LAN, can login using its 
Windows login and credentials, you need to configure this option. 

See page149, Section "6.1 Windows Authentication for Web" for instructions. 



WHAT TO INSTALL WEB SERVER WITH DCOM ACCESS TO REPOSITORY 
 

 

23 

1.4.2. WEB SERVER WITH DCOM ACCESS TO REPOSITORY 

The ECCAIRS 5 Web Server performs a Client connection towards an ECCAIRS 5 Server to forward the 
requests and forward back results to a Web Server User. Therefore you have to configure the 
connection to Repositories on one or more ECCAIRS 5 Servers that you want to make available to Web 
Users: 

This Web Server configuration connects to a networked Repository through DCOM protocol. 

Installation roadmap and checklist 

See page 127, Section "5.1.1 Web Server installation roadmap". 
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1.4.3. WEB SERVER WITH WEB SERVICES ACCESS TO REPOSITORY 

The ECCAIRS 5 Web Server performs a Client connection towards an ECCAIRS 5 Server to forward the 
requests and forward back results to a Web Server User. Therefore you have to configure the 
connection to Repositories on one or more ECCAIRS 5 Servers that you want to make available to Web 
Users: 

This Web Server configuration connects to a networked Repository through Web Services protocol. 

Installation roadmap and checklist 

See page 127, Section "5.1.1 Web Server installation roadmap". 
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1.4.4. WEB SERVER WITH ACCESS TO LOCAL REPOSITORY 

The ECCAIRS 5 Web Server performs a Client connection towards an ECCAIRS 5 Server to forward the 
requests and forward back results to a Web Server User. Therefore you have to configure the 
connection to Repositories on one or more ECCAIRS 5 Servers that you want to make available to Web 
Users: 

A notable and often used configuration is to define connections to Repositories on the local ECCAIRS 5 
Server, installed on the same computer/Server. In this case there is no need to have network access 
protocols (DCOM, Web Services) on the local ECCAIRS 5 Server, unless you want also to allow LAN 
Clients access at the same time. Therefore you may perform a Stand-alone ECCAIRS 5 Server simpler 
configuration. 

Installation roadmap and checklist 

See page 127, Section "5.1.1 Web Server installation roadmap". 
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2. CLIENT INSTALLATION 

This chapter describes how to install the ECCAIRS 5 software on a Client computer (i.e., a Client 
Installation). 

A Client Installation installs all the core ECCAIRS 5 software components and the standard ECCAIRS 
applications but it does not install the Repository Server software components and the "Repository 
Manager" application. 

Do the following: 

 Print the roadmap in Section 2.1 that suites your needs. 
Read the Sections indicated in the roadmap and use the form as checklist for your installation. 

 Print the "Client Installation Data Summary" forms, pages 155 to 156. 
Fill them up with the data and details of the specific installation you are performing. 
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2.1. ROADMAPS AND CHECKLISTS 
In this Section you find all the roadmaps corresponding to the ECCAIRS 5 Client installation options 
illustrated in Section "1.2 Installation options - Client", page 12. 

2.1.1. CLIENT WITH LOCAL CONNECTION 

Print this page and use it as a check-list. 

_____________________________________________________________________________  

 PRINT AND FILL THE INSTALLATION DATA SUMMARY FORMS 
Print the "Client Installation Data Summary" forms (pages 155 to 156) and write down the specific 
configuration parameters and the actual options installed. 

_____________________________________________________________________________  

 CHECK HARDWARE AND SOFWARE REQ. AND PRE-REQUISITES  
See page 31, Section “2.2 Requirements”. 
_____________________________________________________________________________  

 INSTALL CLIENT SOFTWARE  
See page 32, Section “2.3 Install the Client Software”. 
_____________________________________________________________________________  

 START TO CREATE A NEW CONNECTION WITH A REPOSITORY  
See page 35, Section "2.4.1 Get ready to connect to a new Repository/Server". 
_____________________________________________________________________________  

 SETUP CONNECTION TO LOCAL REPOSITORIES  
See page 37, Section "2.4.2 Connect to the Local ECCAIRS Server". 

_____________________________________________________________________________  
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2.1.2. CLIENT WITH DCOM REMOTE CONNECTION 

Print this page and use it as a check-list. 

_____________________________________________________________________________  

 PRINT AND FILL THE INSTALLATION DATA SUMMARY FORMS 
Print the "Client Installation Data Summary" forms (pages 155 to 156) and write down the specific 
configuration parameters and the actual options installed. 

_____________________________________________________________________________  

 CHECK HARDWARE AND SOFWARE REQ. AND PRE-REQUISITES  
See page 31, Section “2.2 Requirements”. 
_____________________________________________________________________________  

 INSTALL CLIENT SOFTWARE  
See page 32, Section “2.3 Install the Client Software” for instructions. 
_____________________________________________________________________________  

 START TO CREATE A NEW CONNECTION WITH A REPOSITORY 
See page 35, Section "2.4.1 Get ready to connect to a new Repository/Server". 
_____________________________________________________________________________  

 SETUP CONNECTION TO REPOSITORIES WITH DCOM PROTOCOLS 
See page 39, Section “2.4.3 Connect to a Remote Server via DCOM” for instructions. 

_____________________________________________________________________________  
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2.1.3. CLIENT WITH WEB SERVICES REMOTE CONNECTION 

Print this page and use it as a check-list. 

_____________________________________________________________________________  

 PRINT AND FILL THE INSTALLATION DATA SUMMARY FORMS 
Print the "Client Installation Data Summary" forms (pages 155 to 156) and write down the specific 
configuration parameters and the actual options installed. 

_____________________________________________________________________________  

 CHECK HARDWARE AND SOFWARE REQ. AND PRE-REQUISITES  
See page 31, Section “2.2 Requirements”. 
_____________________________________________________________________________  

 INSTALL CLIENT SOFTWARE  
See page 32, Section “2.3 Install the Client Software”. 
_____________________________________________________________________________  

 START TO CREATE A NEW CONNECTION WITH A REPOSITORY 
See page 35, Section "2.4.1 Get ready to connect to a new Repository/Server". 
_____________________________________________________________________________  

 SETUP CONNECTION TO REPOSITORIES WITH WEB SERVICES  

 HTTP NON-SECURE PROTOCOLS 
See page 41, Section “2.4.4 Connect to a Remote Server via Web Services”. 

OR (in alternative) 

 HTTPS SECURE PROTOCOLS 
See page 43, Section "2.4.5 Connect to a Remote Server via https Web Services". 

_____________________________________________________________________________  
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2.2. REQUIREMENTS 
Write down your actual hardware/software and pre-requisites data in the "Client Installation Data 
Summary" forms that you have printed from pages 155 to 156. 

Hardware Requirements – ECCAIRS 5 Client 

 HARDWARE REQUIREMENTS 

  CPU: STANDARD  

  RAM: AT LEAST 2 GB  

  HD: 10 MB FREE SPACE  

Software Requirements – ECCAIRS 5 Client 

 SOFTWARE REQUIREMENTS 

 

 OS: 

 Windows 7 (32/64 bit) 

 Vista (32/64 bit) 

 Windows XP SP3 (32/64 bit) 

 Windows Server 2008 R2 (32/64 bit) 

 Windows Server 2003 (32/64 bit) 

 

  .NET 4.0 FULL INSTALLED  

Other Pre-Requisites - ECCAIRS 5 Client 

 PRE-REQUISITES 
 

 At least one ECCAIRS 5 Server installed, 
with: 

 one or more ECCAIRS 5 communication 
protocols enabled (DCOM, Net.TCP, Basic or 
Ws HTTP, Basic or Ws HTTPS)  

 one or more Repositories configured. 
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2.3. INSTALL THE CLIENT SOFTWARE 

The ECCAIRS 5 distributable setup software is a single executable file that you normally download via 
Internet, or read from a CD-ROM /DVD-ROM. 

To install the ECCAIRS 5 Client proceed as follows: 

1. Execute the distributable setup file to extract the setup files. 
You have to specify a folder where the setup files will be put. 

2. Open the folder where the files have been extracted and execute the set-up program called 
"E5ECFSetupV5nnn.exe", where nnn are 3 digits that qualify the specific release you are 
installing. 

3. Accept the license agreement and click on "Next" to continue. 

4. In the subsequent “Select Installation Folder” dialog: 

 Specify the installation folder for your application. 
If possible, keep the default installation folder proposed:  
C:\Program Files\ECCAIRS5 (in 32 bit systems) 
C:\Program Files (x86)\ECCAIRS5 (in 64 bit systems). 

 Select whether the ECCAIRS Client applications will be available in the START menu only for 
the Windows user who is currently installing the software (“Just me”) or for all users 
(“Everyone”, default choice). 

 Click on "Next" to continue. 

5. Select "Client" in the "Installation Type" dialog. 

 

6. In the "Confirm Installation" dialog click on "Next". 
The software installation will start. 

7. When the installation is over a click on the "Finish" button to exit. 
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8. On exiting, the ECCAIRS 5 setup the "Test ECCAIRS 5 Installation" tool is automatically started 
and shows the result of an automatic check of all the software components installed. 
All the items in the "Summary" tab should be ticked and marked in green. 
If any item is not marked in green contact the JRC ECCAIRS Coordination and Development for 
support and/or refer to the "Test ECCAIRS 5 Installation" tool own help and documentation. 
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2.4. CONNECT TO AN ECCAIRS SERVER 

2.4.1. GET READY TO CONNECT TO A NEW REPOSITORY/SERVER 

Whatever the specific communication mode that the client ECCAIRS application will use to connect to a 
repository on an ECCAIRS Server, you have to perform the following preliminary steps: 

1. Launch the "ECCAIRS Browser" application (or any other Client application). 
The "Login" dialog shows up. 
The drop-down list next to Repository is initially empty, In any case, even when already 
populated, let us say that the Repository we want to link is not yet in the drop-down list. 

 

2. Click the "More" button, and then the "Add" button to display the "Add Repository" dialog. 
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3. The "Add Repository" dialog pops up.  
Follow the instructions for the specific protocol in the next few Sections. 

 



CLIENT INSTALLATION CONNECT TO THE LOCAL ECCAIRS SERVER 
 

 

37 

2.4.2. CONNECT TO THE LOCAL ECCAIRS SERVER 

The "Local Server" configuration can be used only when the Client is accessing a Repository on the 
Server installed on the same computer. 

 

The red-dashed box shows where we are now in the setup options-tree. 
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To connect to a Repository on the local ECCAIRS Server, perform the following steps: 

1. Select "Local Server" in the "Protocol Type" drop-down list. 

 

2. Click on the "List" button: all the Repositories available on the local Server will be listed in the 
"Repositories" box. 

3. Select the Repository and click on "OK". 

4. Perform a login from the client to verify that the Repository has been correctly enabled. 

Repository link Aliases 

You may assign an Alias to the Repository link that you are defining so that you can make more 
meaningful the Repository name to select. This may be used to tell apart Repositories with the same 
name located on different Repository Servers. 

See page 43, Section "2.4.6 Using an Alias for a Repository Connection". 
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2.4.3. CONNECT TO A REMOTE SERVER VIA DCOM 

 

The red-dashed box shows where we are now in the setup options-tree. 
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To connect to a Repository on a remote ECCAIRS Server using DCOM, perform the following steps: 

1. Select "DCOM" in the "Protocol Type" drop-down list. 

2. Specify the Server name. You can also click on the "Browse" button and browse the network for 
DCOM Server. 

 

3. Enter the network password, which is the one defined for the E5Administrator user when 
installing and configuring the ECCAIRS 5 Server. See Section "3.6.1 Create and configure the 
E5Administrator User", page 64. 

4. Click on the "List" button: all the Repositories available on the local Server will be listed in the 
"Repositories" box. 

5. Select the Repository and click on "OK". 

6. Perform a login from the client to verify that the Repository has been correctly enabled. 

Repository link Aliases 

You may assign an Alias to the Repository link that you are defining so that you can make more 
meaningful the Repository name to select. This may be used to tell apart Repositories with the same 
name located on different Repository Servers. 

See page 43, Section "2.4.6 Using an Alias for a Repository Connection". 
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2.4.4. CONNECT TO A REMOTE SERVER VIA WEB SERVICES 

 

The red-dashed box shows where we are now in the setup options-tree. 

This case involves connection to a ECCAIRS Server using Web Services over non-secured protocols.   

If you wish to use a secure protocol (https) to access the ECCAIRS Server via Web Services, then you 
have to follow a different procedure.  
See page 43, Section "2.4.5 Connect to a Remote Server via https Web Services". 
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First follow the instructions in Section "2.4.1 Get ready to connect to a new Repository/Server", page 35, 
to display "Add Repository" dialog. 
Then perform the following steps  

1. Select "Web Service" in the "Protocol Type" drop-down list. 

 

2. In the "Service Type" drop-down list that shows up just below you can select Net.TCP, Basic 
HTTP, WS HTTP protocols. 

3. Type in the "Service Address" text box the Web Service access address provided by the 
ECCAIRS System Administrator (see also below). 

Examples and details on the Web Service address 

If during the Server installation the Administrator has filled in "Summary of Options Installed - ECCAIRS 
5 Server (Network-accessible)" report form, printed from page 163, then you find the Web Service 
address noted down in the "WEB SERVER ACCESS ADDRESS" fields in the: 

 "Net.TCP CLIENT NETWORK ACCESS" form section 

 "Ws HTTP / Basic HTTP NETWORK ACCESS (via Windows Service)" form section 

 "Ws HTTP / Basic HTTP NETWORK ACCESS (via IIS)" form section 

The address is a result of the specific Server configurations made for providing Web Services access. 
See page 69, Section "3.7 Setup access via Web Services (by Windows Service)" or page 74, Section 
"3.8 Setup access via Web Services (by IIS)". 

As a background information, the full net address of the service is in one of the forms: 

 http://myserver.myorg.com:8731/eccairs5/ws (for "Ws HTTP") 

 http://myserver.myorg.com:8735/eccairs5/basic (for "Basic HTTP") 

 net.tcp://myserver.myorg.com:19566/eccairs5/nettcp (for "Net.TCP") 
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where: "eccairs5" is the service name that the Administrator has set. The default may however have 
been changed during configuration. Refer to the installation report form mentioned above for the correct 
service name string. 

The Server address also includes, or may include, a TCP port specification, which is appended to the 
address after a "column" character (e.g. myserver.myorg.com:8731) appended. The port is et during 
configuration. Refer to the installation report form mentioned above for the port-complete Server 
address. 

Repository link Aliases 

You may assign an Alias to the Repository link that you are defining so that you can make more 
meaningful the Repository name to select. This may be used to tell apart Repositories with the same 
name located on different Repository Servers. 

See page 43, Section "2.4.6 Using an Alias for a Repository Connection". 

 

2.4.5. CONNECT TO A REMOTE SERVER VIA HTTPS WEB SERVICES 

 

The red-dashed box shows where we are now in the setup options-tree. 

This case involves connection to a ECCAIRS Server using Web Services over a secure protocol (https).   
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Import the Server security certificate into the Client computer 

To perform the configuration you must have access to the same certificate that has been used to setup 
the Server. So you need to have it on the Client computer, either on removable storage or network share 
or even, maybe, received ad E-Mail attachment. 

Then perform the following steps:  

1. Select START > RUN from the Windows START button and type "mmc" in the "Open" text box of 
the "Run" dialog that shows up. 

2. Confirm the action, if the Windows UAC protection system ask you for it. 

3. The "Console1 - [Console Root]" window is displayed. 

 

4. Select the "File > Add/Remove Snap-in" menu-item: "Add or Remove Snap-ins" dialog shows 
up. 

5. Select "Certificates" in the left panel of the "Add or Remove Snap-ins" dialog that shows up. 

6. Click the "Add >" button to add it to the right panel: the "Certificates snap-in" dialog shows up. 
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7. Select the "Computer account" option so that the configuration will be valid for all the users of 
the computer you are setting now. Click on "Next".  

8. The next screen "Select Computer" shows up. 
Click on "Finish" to confirm that the snap-in will manage the computer you are setting now 
(default choice).  

 

9. The "Certificates (Local Computer)" snap-in is now listed among the selected snap-ins in the right 
panel. 
Click "OK" to confirm and exit the "Add or Remove Snap-ins" dialog. 
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10. Now, back in the "Console1 - [Console Root]" window, select in the left panel tree the 
"Certificates (Local Computer) > Trusted Root Certification Authorities > Certificates" node. 

11. The middle panel now displays all the Certificates known to the computer. 

12. Still on the "Certificates" node in the left panel, select the "Right-click > All Tasks > Import..." 
menu-item, using the Right-click contextual menu. 
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13. In the "Certificate Import Wizard" that shows up click "Next >" and in the next screen click 
"Browse..." to select the certificate file that has been used to secure the web-service in the 
ECCAIRS Server.  
If the Certificate is password protected you will need to enter the password to access it. 

 

14. Then click "Next ...". In this screen leave the default choice as it is, e.g. store all the certificates in 
the "Trusted Root Certification Authorities" pool and then click "Next >" again. 

15. Click on "Finish" in the completion page of the wizard to confirm and exit.  

16. Click "OK" in the acknowledge info dialog that shows up. 

17. Close the "Console1 - [Console Root]" console management window. 

Configure the protocols and service access addresses in the Client login dialog 

Now, to be able to access a Repository using the secure web service, you need to add a link to a 
Repository specifying the correct protocol and address. 

To connect to a Repository on a remote ECCAIRS Server using HTTPS Secured Windows Services, first 
follow the instructions in Section "2.4.1 Get ready to connect to a new Repository/Server", page 35, to 
display "Add Repository" dialog. 



CLIENT INSTALLATION CONNECT TO A REMOTE SERVER VIA HTTPS WEB SERVICES 
 

 

48 

Then perform the following steps  

1. Select "Web Service" in the "Protocol Type" drop-down list. 

 

2. In the "Service Type" drop-down list that shows up select Basic HTTPS or WS-HTTPS protocols. 

3. Type in the "Service Address" text box the Web Service access address provided by the 
ECCAIRS System Administrator (see also below). 

Examples and details on the Web Service address 

If during the Server installation the Administrator has filled in "Summary of Options Installed - ECCAIRS 
5 Server (Network-accessible)" report form, printed from page 163, then you find the Web Service 
address noted down in the "WEB SERVER ACCESS ADDRESS" fields of the "Ws HTTPS / Basic 
HTTPS NETWORK ACCESS (via IIS)". 

The address is a result of the specific Server configurations made for providing Web Services access. 
See page 74, Section "3.8 Setup access via Web Services (by IIS)". 

As a background information, the full net address of the service is in the form: 

 https://myserver.myorg.com/eccairs5/service.svc/ws-https (for "Ws HTTPS") 

 https://myserver.myorg.com/ eccairs5/service.svc/basic-https (for "Basic HTTPS") 

where: "eccairs5" is the service name (Alias/virtual directory) that the Administrator has set. The default 
may however have been changed during configuration. Refer to the installation report form mentioned 
above for the correct service name string. 

Repository link Aliases 

You may assign an Alias to the Repository link that you are defining so that you can make more 
meaningful the Repository name to select. This may be used to tell apart Repositories with the same 
name located on different Repository Servers. 

See page 43, Section "2.4.6 Using an Alias for a Repository Connection". 
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2.4.6. USING AN ALIAS FOR A REPOSITORY CONNECTION 

The name of Repositories is set within the ECCAIRS 5 Server, when defining a new Repository. 

In addition you can define an "Alias" that can be used by the Client applications to display a more 
meaningful Repository name in the "login" dialog. 

The use of an Alias becomes mandatory if you are referencing a Repository on a Server, but you already 
have a reference to a Repository with the same name hosted on another Server. 

For instance, you have a Repository called ‘REP1’ on a Server called ‘SRV1’, and you are connecting to 
a Server called ‘SRV2’ where a Repository called ‘REP1’ is also available. 

Because of the fact that ECCAIRS uses the Repository’s name for associating the target Server, then 
‘REP1’ is not sufficient for uniquely identifying the correct Server. 

The Repository Alias bypasses this limitation, because it allows defining a free format unique identifier 
for the Repository. In the example, a valid Alias could be ‘REP1 on SRV2’. ‘REP1’ would continue to 
reference the ‘SRV1’ Server. 

To create an Alias perform the following steps: 

1. Launch the "ECCAIRS Browser" application (or any other Client application). 
The "Login" dialog shows up. 

 

2. Select the Repository that you want to assign an "Alias" in the "Repository" drop-down list. 
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3. Click the "More" button, and then the "Edit" button to display the "Add Repository" dialog. 

 

4. Enter the "Alias" name in the corresponding field at the bottom. 

5. Click on "OK" to confirm. 

The next time you login the Repository "Alias" name you have entered will be listed in the "Repository" 
drop-down list on the "Login" dialog. 
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3. SERVER INSTALLATION 

This chapter describes how to install the ECCAIRS 5 software on a Server Machine (i.e. a Server 
Installation). 

A ECCAIRS 5 Server installation installs all the standard basic ECF components, the applications 
(Browser, Grapher, Data Manager, etc.) and the tool to create and configure Repositories: the 
Repository Manager. More information was given in Section "1.3 Installation options - Server", page 15. 

Do the following: 

 Print the roadmap in Section 3.1 that suites your needs. 
Read the Sections indicated in the roadmap and use the form as checklist for your installation. 

 Print the "Server Installation Data Summary" forms,  
pages 157 to 159  (for Stand-alone Servers) 
pages 161 to 166 (for Network-accessible Servers) 
Fill them up with the data and details of the specific installation you are performing. 
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3.1. ROADMAPS AND CHECKLISTS 
In this Section you find all the roadmaps corresponding to the client installation options illustrated in 
Section "1.3 Installation options - Server", page 15. 

3.1.1. STAND-ALONE SERVER ROADMAP 

Optional steps are marked in green. Print this page and use it as check-list for your installation. 

_____________________________________________________________________________  

 PRINT AND FILL THE INSTALLATION DATA SUMMARY FORMS 
Print the "Installation Data Summary" forms (pages 157 to 159) and write down the specific 
configuration parameters and the actual options installed. 

_____________________________________________________________________________  

 CHECK HARDWARE AND SOFWARE REQ. AND PRE-REQUISITES  
See page 56, Section “3.2 Requirements (Stand-alone Server)” for instructions and fill your 
printed installation forms. 
_____________________________________________________________________________  

 INSTALL SERVER SOFTWARE 
See page 60, Section "3.4 Install the Server software"  

_____________________________________________________________________________  

 INSTALL AN EXTENSION 
See page 89, Section "3.9 Install an Extension". 

_____________________________________________________________________________  

 SETUP OCCURRENCE DATABASE  
See page 96, Section "3.11 Setup Occurrence databases". 

_____________________________________________________________________________  

 CREATE A REPOSITORY 
See page 104, Section "3.12 Setup Repositories". 

_____________________________________________________________________________  

 IF NEEDED, PERFORM OPTIONAL COMPONENTS INSTALLATION 
See page 115, Section "4.1 Additional services available" for the list of optional server 
components and instructions. 

_____________________________________________________________________________  
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3.1.2. SERVER WITH DCOM ACCESS ROADMAP 

Optional steps are marked in green. Print this page and use it as check-list for your installation. 

_____________________________________________________________________________  

 PRINT AND FILL THE INSTALLATION DATA SUMMARY FORMS 
Print the "Installation Data Summary" forms (pages 161 to 163) and write down the specific 
configuration parameters and the actual options installed. 

_____________________________________________________________________________  

 CHECK HARDWARE AND SOFWARE REQ. AND PRE-REQUISITES  
See page 58, Section "3.3 Requirements (Network-accessible Server)" for instructions and fill 
your printed installation forms. 

_____________________________________________________________________________  

 INSTALL SERVER SOFTWARE 
See page 60, Section "3.4 Install the Server software". 

_____________________________________________________________________________  

 CONFIGURE DCOM ACCESS  
See page 63, Section "3.6 Setup access via DCOM". 

_____________________________________________________________________________  

 IF NEEDED, CONFIGURE OTHER ACCESS PROTOCOLS 
Note that you can install also other access protocols on the same Server. 

 See page 69, Section "3.7 Setup access via Web Services (by Windows Service)". 

 See page 74, Section "3.8 Setup access via Web Services (by IIS)". 

_____________________________________________________________________________  

 INSTALL AN EXTENSION 
See page 91, Section "3.10 Install an Extension". 

_____________________________________________________________________________  

 SETUP OCCURRENCE DATABASE  
See page 96, Section "3.11 Setup Occurrence databases". 

_____________________________________________________________________________  

 CREATE A REPOSITORY 
See page 104, Section "3.12 Setup Repositories". 

_____________________________________________________________________________  

 IF NEEDED, PERFORM OPTIONAL COMPONENTS INSTALLATION 
See page 115, Section "4.1 Additional services available" for the list of optional server 
components and instructions. 

_____________________________________________________________________________  
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3.1.3. SERVER WITH WEB SERVICES ACCESS VIA WINDOWS SERVICE 

Optional steps are marked in green. Print this page and use it as check-list for your installation. 

_____________________________________________________________________________  

 PRINT AND FILL THE INSTALLATION DATA SUMMARY FORMS 
Print the "Installation Data Summary" forms (pages 161 to 163) and write down the specific 
configuration parameters and the actual options installed. 

_____________________________________________________________________________  

 CHECK HARDWARE AND SOFWARE REQ. AND PRE-REQUISITES  
See page 58, Section "3.3 Requirements (Network-accessible Server)" to check the requirements 
and fill your printed installation forms. 

_____________________________________________________________________________  

 INSTALL SERVER SOFTWARE 
See page 60, Section "3.4 Install the Server software"  

_____________________________________________________________________________  

 CONFIGURE WEB SERVICES ACCESS VIA WINDOWS SERVICE 
See page 69, Section "3.7 Setup access via Web Services (by Windows Service)"  

_____________________________________________________________________________  

 IF NEEDED, CONFIGURE OTHER ACCESS PROTOCOLS 
You can configure other access protocols on the same Server. 

 See page 63, Section "3.6 Setup access via DCOM"  

 See page 74, Section "3.8 Setup access via Web Services (by IIS)" 

_____________________________________________________________________________  

 INSTALL AN EXTENSION 
See page 89, Section "3.9 Install an Extension". 

_____________________________________________________________________________  

 SETUP OCCURRENCE DATABASE  
See page 96, Section "3.11 Setup Occurrence databases". 

_____________________________________________________________________________  

 CREATE A REPOSITORY 
See page 104, Section "3.12 Setup Repositories". 

_____________________________________________________________________________  

 IF NEEDED, PERFORM OPTIONAL COMPONENTS INSTALLATION  
See page 115, Section "4.1 Additional services available" for the list of optional server 
components and instructions. 

_____________________________________________________________________________  
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3.1.4. SERVER WITH WEB SERVICES ACCESS VIA IIS 

Optional steps are marked in green. Print this page and use it as check-list for your installation. 

_____________________________________________________________________________  

 PRINT AND FILL THE INSTALLATION DATA SUMMARY FORMS 
Print the "Installation Data Summary" forms (pages 161 to 163) and write down the specific 
configuration parameters and the actual options installed. 

_____________________________________________________________________________  

 CHECK HARDWARE AND SOFWARE REQ. AND PRE-REQUISITES  
See page 58, Section "3.3 Requirements (Network-accessible Server)" for instructions and fill 
your printed installation forms. 
In particular remember you need to have IIS installed and running in this case. 
_____________________________________________________________________________  

 INSTALL SERVER SOFTWARE 
See page 60, Section "3.4 Install the Server software"  

_____________________________________________________________________________  

 CONFIGURE WEB SERVICES ACCESS VIA IIS 
See page 74, Section "3.8 Setup access via Web Services (by IIS)" 
There are different instructions for Basic/WS HTTP and Basic/WS HTTPS (secure) versions. 

_____________________________________________________________________________  

 IF NEEDED, CONFIGURE OTHER ACCESS PROTOCOLS 
You can configure other access protocols on the same Server. 

 See page 63, Section "3.6 Setup access via DCOM"  

 See page 69, Section "3.7 Setup access via Web Services (by Windows Service)"  

_____________________________________________________________________________  

 INSTALL AN EXTENSION 
See page 89, Section "3.9 Install an Extension". 

_____________________________________________________________________________  

 SETUP OCCURRENCE DATABASE  
See page 96, Section "3.11 Setup Occurrence databases". 

_____________________________________________________________________________  

 CREATE A REPOSITORY 
See page 104, Section "3.12 Setup Repositories". 

_____________________________________________________________________________  

 IF NEEDED, PERFORM OPTIONAL COMPONENTS INSTALLATION 
See page 115, Section "4.1 Additional services available" for the list of optional server 
components and instructions. 

_____________________________________________________________________________  
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3.2. REQUIREMENTS (STAND-ALONE SERVER) 
Remember to fill the "Web Server Installation Data Summary" forms you printed (from pages 157 to 159) 
with the specific Hardware, Software and Pre-requisites of the installation you are performing. 

Optional requirements, suitable only to specific installation choices or options, are marked with a pale 
green background. 

Hardware Requirements - ECCAIRS 5 Server (Stand-alone) 

 HARDWARE REQUIREMENTS 

  CPU: STANDARD  

  RAM: AT LEAST 2 GB  

 
 HD: 200 MB FREE SPACE for the ECCAIRS 5 

Server, plus possible additional space (see 
options below) 

 

O
P

T
IO

N
 

 HD ADDITIONAL SPACE, if the ECCAIRS 5 
Server host s the Occurrence and/or 
Attachments database. 
Consider: 

 300 kB per Occurrence 

 Suitable Attachments space 

 

Software Requirements - ECCAIRS 5 Server (Stand-alone) 

 SOFTWARE REQUIREMENTS 

 

 OS: 

 Windows 7 (32/64 bit) 

 Vista (32/64 bit) 

 Windows XP SP3 (32/64 bit) 

 Windows Server 2008 R2 (32/64 bit) 

 Windows Server 2003 (32/64 bit) 

 

  .NET 4.0 FULL INSTALLED  

 
 OCCURRENCE AND ATTACHMENTS 

RDBMS EXISTS, either local or remote 

 

O
P

T
IO

N
 

 LOCAL OCCURRENCE RDBMS (DATABASE 
Server), if the ECCAIRS 5 Server also hosts 
the Occurrence and/or Attachments database. 

 Microsoft SQL Server 2005 and 2008 (both 
express and enterprise versions) 

 Oracle (version 10.2 or greater) 
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O
P

T
IO

N
  ORACLE DATABASE CLIENT SOFTWARE 

only when the Occurrence and/or Attachment 
databases are hosted in an Oracle RDBMS: 

 32 bit Oracle client with ODAC components 
installed 

 

 
 

Other Pre-Requisites - ECCAIRS 5 Server (Stand-alone) 

 PRE-REQUISITES 

 

 ORGANISATION ID 
Required for to create Repositories for your 
own Organisation: 
(get it from JRC ECCAIRS Co-ordination 
Centre) 

 

 

O
P

T
IO

N
 

 REMOTE OCCURRENCE AND 
ATTACHMENTS RDBMS (DATABASE 
Server), if the Occurrence and/or Attachments 
database are hosted on another computer. 

 Microsoft SQL Server 2005 and 2008 (both 
express and enterprise versions) 

 Oracle (version 10.2 or greater) 
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3.3. REQUIREMENTS (NETWORK-ACCESSIBLE SERVER) 
Remember to fill the "Server Installation Data Summary" forms you printed (from pages 161 to 166) with 
the specific Hardware, Software and Pre-requisites of the installation you are performing. 

Optional requirements, suitable only to specific installation choices or options, are marked with a pale 
green background. 

Hardware Requirements - ECCAIRS 5 Server (Network-accessible) 

 HARDWARE REQUIREMENTS 

 
 CPU: STANDARD, DUAL CORE 

SUGGESTED 
 

  RAM: AT LEAST 2 GB  

 
 HD: 200 MB FREE SPACE for the ECCAIRS 5 

Server, plus possible additional space (see 
options below) 

 

O
P

T
IO

N
  HD ADDITIONAL SPACE, if the ECCAIRS 5 

Server also hosts the Occurrence and/or 
Attachments database. 

 300 kB per Occurrence 

 Suitable Attachments space 

 

Software Requirements - ECCAIRS 5 Server (Network-accessible) 

 SOFTWARE REQUIREMENTS 

 

 OS: 

 Windows 7 (32/64 bit) 

 Vista (32/64 bit) 

 Windows XP SP3 (32/64 bit) 

 Windows Server 2008 R2 (32/64 bit) 

 Windows Server 2003 (32/64 bit) 

 

  .NET 4.0 FULL INSTALLED  

O
P

T
IO

N
 

 IIS 6 or IIS 7 INSTALLED AND CONFIGURED
only if remote clients use Web Services (Basic 
HTTP / Ws HTTP) to connect to this ECCAIRS 
5 Server and you want these services to be 
hosted by IIS. 

 

 

 
 OCCURRENCE AND ATTACHMENTS 

RDBMS EXISTS, either local or remote 
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O
P

T
IO

N
 

 REMOTE OCCURRENCE AND 
ATTACHMENTS RDBMS (DATABASE 
Server), if the Occurrence and/or Attachments 
database are hosted on another computer. 

 Microsoft SQL Server 2005 or higher (both 
express and enterprise versions) 

 Oracle (version 10.2 or higher) 

 

 

Other Pre-Requisites - ECCAIRS 5 Server (Network-accessible) 

 PRE-REQUISITES 

 

 ORGANISATION ID 
Required for to create Repositories for your 
own Organisation: 
(get it from JRC ECCAIRS Co-ordination 
Centre) 

 

 

 

O
P

T
IO

N
 

 LOCAL OCCURRENCE RDBMS (DATABASE 
Server), if the ECCAIRS 5 Server also hosts 
the Occurrence and/or Attachments database. 

 Microsoft SQL Server 2005 or higher (both 
express and enterprise versions) 

 Oracle (version 10.2 or higher) 

 

O
P

T
IO

N
  ORACLE DATABASE CLIENT SOFTWARE 

only when the Occurrence and/or Attachment 
databases are hosted in an Oracle RDBMS: 

 32 bit Oracle client with ODAC components 
installed 

 



SERVER INSTALLATION INSTALL THE SERVER SOFTWARE 
 

 

60 

3.4. INSTALL THE SERVER SOFTWARE 
The ECCAIRS 5 distributable setup software is a single executable file that you normally download via 
Internet, or read from a DVD-ROM. 

To install the ECCAIRS 5 Client proceed as follows: 

1. Execute the distributable setup file to extract the setup files. 
You have to specify a folder where the setup files will be put. 

2. Open the folder where the files have been extracted and execute the set-up program called 
"E5ECFSetupV5nnn.exe", where nnn are 3 digits that qualify the specific release you are 
installing. 

3. Accept the license agreement and click on "Next" to continue. 

4. In the subsequent “Select Installation Folder” dialog: 

 Specify the installation folder for your application. 
If possible, keep the default installation folder proposed:  
C:\Program Files\ECCAIRS5 (in 32 bit systems) 
C:\Program Files (x86)\ECCAIRS5 (in 64 bit systems). 
If you decide to change the installation folder, write down its full path in the "Server 
Installation Summary" form (page 159 for Stand-alone Server or page 163 for network-
accessible Server). References to this folder will be made further on within this Manual. 

 Select whether the ECCAIRS Client applications will be available in the START menu only for 
the Windows user who is currently installing the software (“Just me”) or for all users 
(“Everyone”, default choice). 

 Click on "Next" to continue. 

5. Select "Server" in the "Setup Type" dialog and click on "Next" to continue. 

 

6. In the "Ready to install the Program" dialog click on "Install". 
The software installation will start. 

7. When the installation is over a click on the "Finish" button to exit. 
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8. On exiting, the ECCAIRS 5 setup the "Test ECCAIRS 5 Installation" tool is automatically started 
and shows the result of an automatic check of all the software components installed. 
All the items in the "Summary" tab should be ticked and marked in green. 
If any item is not marked in green contact the JRC ECCAIRS Coordination and Development for 
support and/or refer to the "Test ECCAIRS 5 Installation" tool own help and documentation. 
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3.5. SETUP ACCESS TO A STAND-ALONE SERVER 
For a standalone installation (Client and Server on the same physical machine) no particular 
configuration is required on the Server. 

 

 

When connecting the local Client applications (i.e. on the same computer as the Server) to a Repository 
on the local Server, the "Protocol Type" to select is "Local Server". 

The "Local Server" mode allows to connect directly to the local server without using any remote 
communication technology. 

See page 35, Section "2.4.1 Get ready to connect to a new Repository/Server" and page 37, Section 
"2.4.2 Connect to the Local ECCAIRS Server". 

There is no special setup to make after installing the software but you need to perform a number of tasks 
before being able to operate the ECCAIRS 5 Server, as with all the ECCAIRS 5 Server configurations. 

See page 89, Section "3.9 Tasks needed to operate the Server". 
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3.6. SETUP ACCESS VIA DCOM 
A client can remotely connect to a server using the same protocol (DCOM) as was supported in the 
previous ECCAIRS Releases. 

In addition to DCOM, ECCAIRS Release 5 supports Web Services communication protocols and you 
can setup more than one access protocol on the same Server. 

 See page 69, Section "3.7 Setup access via Web Services (by Windows Service). 

 See page 74, Section "3.8 Setup access via Web Services (by IIS)" 

 

 

The red-dashed box shows where we are now in the setup options-tree. 
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3.6.1. CREATE AND CONFIGURE THE E5ADMINISTRATOR USER 

Create and configure a E5Administrator user as follows: 

1.  CREATE A NEW USER 

 Right-click on the "Computer" icon on the Desktop and select "Manage". 

 From the "Server Manager" Root node select the "Configuration" node. 

 Select the "Local Users and Group" node. 

 Select the "Users" node, then right-click in the main pane and choose "New User". 

2. SET E5Administrator USER AND PROPERTIES 

 Enter "E5Administrator" as new user name. 

 Deselect the "User must change password…". 

 Select the "User cannot change password". 

 Select the "Password never expires". 

 Assign a suitable password and store it in a safe place. You should write down the password 
in the "Summary of Options Installed - ECCAIRS 5 Server (Network-accessible)" form, page 
163, that you have printed before starting the installation. 
The password assigned to "E5Administrator" is the network password needed for accessing 
this Server from a Client (see Section "2.4.3 Connect to a Remote Server via DCOM", page 
39). 

  Click on the "Create" button, and then click the “Close” button. 

3. ASSIGN GROUP MEMBERSHIP  

 The "Users" main pane will now contain the "E5Administrator" user. 

 Select "E5Administrator" and then "Right-click > Properties". 

 Click on the "Member Of" tab and add "Distributed COM Users" (Windows Server 2003, 
2008 and 7 only). 

 Apply the changes and exit. 

4. ASSIGN USER RIGHTS 

 For Windows Server 2003: 

o Click on "Administrative Tools - Local Security Policy". The "Local Security Settings" 
window opens 

o Select "User Rights Assignment" 

o Assign the "Log on as a Batch Job" user rights to "E5Administrator": 

 For Windows Server 2008: 

o Go to "Local Security Policy".  

o Select "Local Policies". 

o Select "User Rights Assignment". 

o Assign the "Log on as a Batch Job" user rights to "E5Administrator". 

Proceed with next section, "3.6.2 General DCOM configuration". 
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3.6.2. GENERAL DCOM CONFIGURATION 

In order to allow remote connections towards the Server, DCOM Configuration of the "E5RSServer" 
software component is required. 

To perform the general DCOM Configuration, perform the following steps: 

1. Select "START > Run" and type: 

 dcomcnfg (for 32 bit systems)  

 comexp.msc -32 (for 64 bit systems) 

2. The "Component Services" dialog opens. 

3. From the root node select "Component Services > My Computer" node. 

4. Select the "Right-click > Properties" menu-item. 
The "My Computer - Properties" dialog opens. 

5. Select the "COM Security" tab-panel. 

6. Click on the "Edit Limits" button within the "Access Permissions" box (the upper box). A dialog 
opens. 

 Make sure that the "Distributed COM Users" group is present in the list". 
If not yet present, add it. 

 Allow (check) both "Local Access" and "Remote Access". 

 Click on "OK" to confirm and close the dialog. 

7. Back in the "COM Security" tab-panel, click on the "Edit Default" button within the "Access 
Permissions" box (the upper box). 
An "Access Permission" dialog shows up. 

 

 Make sure that the "SELF" and "SYSTEM" user groups are present, with "Local Access" and 
"Remote Access" checked. 

 If not, check them for both groups. 

 Click on "OK" to confirm and close the dialog. 
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8. Back in the "COM Security" tab-panel click on the "Edit Limits" button within the "Launch and 
Activation Permissions" box (the lower box). 

 Make sure that the "Distributed COM Users" group is present in the list. 
If not yet present, add it. 

 Allow (check) all permissions. 

 Click on "OK" to confirm and close the dialog. 

9. Back in the "COM Security" tab-panel click on the "Edit Default" button within the "Launch and 
Activation Permissions" box (the lower box). 
A "Launch Permission" dialog shows up. 

 

 Make sure that the "SYSTEM" and "INTERACTIVE" user groups are present, with all the 
permissions granted. 

 Click on "OK" to confirm and close the dialog. 

10. Back in the "COM Security" tab-panel, click on "OK" to confirm and close the "My Computer - 
Properties" dialog. 

Proceed with next section, "3.6.3 E5RSServer component DCOM Configuration". 

3.6.3. E5RSSERVER COMPONENT DCOM CONFIGURATION 

To configure the ECCAIRS 5 Repository Services component, perform the following steps: 

1. Select the ECCAIRS 5 Repository Services icon (it should be the first item in the list). 

2. Select "Right-click > Properties" menu-item. 
A "Property" dialog with multiple tabs shows up. 

3. In the "General" tab select "Connect" as "Authentication Level". 

4. In the "Location" tab make sure that the "Run application on this computer" option is selected. 

5. In the "Security" tab perform the following operations: 
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 In the "Launch and Activation Permissions" panel click on "Customize" and then on 
"Edit". 

 Add the "E5Administrator" user and make sure all the permissions are granted. 

 In the "Access Permissions" panel click on "Customize" and then on "Edit". 

 Add the "E5Administrator" user and make sure all the permissions are granted. 

 Leave the options for "Configuration Permissions" as they are. 

6. In the "Identity" tab make sure that the "The Launching User" option is selected. 

7. Confirm with "OK" all the selections made. 

Proceed with next section, "3.6.4 Configure Windows Firewall". 

3.6.4. CONFIGURE WINDOWS FIREWALL  

In order to allow remote Client connections towards the ECCAIRS Server, some configuration is required 
in the Windows Firewall. 

Two rules have to be created in order to make the system work properly: a rule for the DCOM port and a 
rule for the E5RSServer application. 

The instructions illustrated below refers to the Windows built-in Firewall in Windows 7/Windows Server 
2008. 

If you use a third party software firewall or an hardware firewall instead, make sure that you perform 
equivalent settings. 

To setup DCOM access firewall rules perform the following steps: 

1. Select "START > Control Panel > Windows Firewall". 
The main configuration window will appear. 

2. Click on the "Advanced Settings" option (on the left of the main configuration window of 
Windows Firewall). The "Advanced Security" windows shows up. 

3. Select the "Inbound Rules" node. 

 

4. ECCAIRS Programs rule 
Perform the following steps: 

 Click on the "New Rule "option on the top right corner of the Advanced Security window. 

 In the Rule Type "window, choose "Program" and click on "Next". 

 In the "Program" window: 

o Select the "This program path:" option 
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o Browse to the path where you have installed ECCAIRS (that you have written down in the 
"Summary of Options Installed - ECCAIRS 5 Server (Network-accessible)" form, printed 
from page 163). 

o Select the "E5RSServer.exe" application and click on "Next". 

 In the "Action" window leave the Allow the connection" option selected and click on "Next". 

 In the "Profile" window leave all the options ticked and click "Next". Depending on your 
specific IT environment setup you may wish to tick only some of the options. 

 Provide a name for the rule. 
Suggested name: "ECCAIRS Programs". 

5. Create ECCAIRS DCOM Port rule 
Perform the following steps: 

 Click on the "New Rule" option on the top right corner of the Advanced Security window. 

 In the "Rule Type" windows choose "Port" and click on "Next". 

 In the "Protocol and Ports" window specify the TCP port number (135) and click on "Next". 

 In the "Action" window leave the "Allow the connection" option selected and click on 
"Next". 

 In the "Profile" window leave all the options ticked and click on "Next". 

 Provide a name for the rule. 
Suggested name: "ECCAIRS DCOM Port". 

 

The new rules are enabled by default. 
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3.7. SETUP ACCESS VIA WEB SERVICES (BY WINDOWS 
SERVICE) 

A client can connect to the server using protocol types based on Web Services. 

A Web Service access can be provided in two different ways:  

 using a Windows Service, which is the subject of this Section. 

 hosting the application inside IIS. See page 74, Section "3.8 Setup access via Web Services (by 
IIS)"  

In any case you can setup more than one access protocol on the same Server. 

 See page 63, Section "3.6 Setup access via DCOM". 

 See page 74, Section "3.8 Setup access via Web Services (by IIS)". 

 

The red-dashed box shows where we are now in the setup options-tree. 

 

Follow the instructions given in the next Sections to configure this option. 
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3.7.1. CONFIGURE THE WINDOWS SERVICE 

The Windows Service mode offers three already preconfigured service types: 

 Basic HTTP 

 Ws HTTP 

 Net.TCP. 

The Web Services address has to be set in "E5WindowsServer.config" file. 

IMPORTANT: to edit the "E5WindowsServer.config" file you first have to disable its read-only 
attribute. 

The file is installed by the ECCAIRS 5 setup and it is by default placed in the following locations: 

 Windows Server 2003, Windows XP:  
C:\Documents and Settings\All Users\Application Data\ECCAIRS 5\Settings 

 Windows Server 2008, Windows Vista and Windows 7: 
C:\ProgramData\ECCAIRS 5\Settings 

IMPORTANT:  

 the ECCAIRS Settings folder is a sub-folder of the Program/Application data Windows 
folder, which is set as "hidden". To be able to locate it you need to enable the visualisation of 
"hidden files and folders". 

 to edit the "E5WindowsServer.config" file you first have to disable its read-only attribute. 

The file is an XML text file, so open it with Notepad, or any other pure text/code editor, and locate the 
"service" node that enumerates all the available service types this line: 

<service name="ECCAIRS5.Repository.Server.erssSrvConnector"> 

   <endpoint address="/ws" 

       binding="wsHttpBinding" bindingConfiguration="wsHttpBindingConfig" 

       contract="ECCAIRS5.Repository.Client.erscISrvConnector"/> 

   <endpoint address="/netTcp" 

       binding="netTcpBinding" bindingConfiguration="netTcpEndpointConfig" 

       contract="ECCAIRS5.Repository.Client.erscISrvConnector"/> 

   <endpoint address="/basic" 

       binding="basicHttpBinding" bindingConfiguration="basicHttpBindingConfig" 

       contract="ECCAIRS5.Repository.Client.erscISrvConnector" />               

   <host> 

      <baseAddresses> 

         <add baseAddress ="http://localhost:8731//ECCAIRS5"/> 

         <add baseAddress ="net.tcp://localhost:8735//ECCAIRS5"/> 

      </baseAddresses> 

   </host> 

</service> 

The default configuration  assumes that ports numbered 8731 and 8735 are available in your server 
environment. You can use other (free) port numbers if you wish. Note down the ports actually used in the 
"Summary of Options Installed - ECCAIRS 5 Server (Network-accessible) "form, printed from page 163. 
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Corresponding client addresses used to access the Server 

The address that the ECCAIRS Client application will use to access the Server via Web Services is 
composed by "<baseAddress>+<endpoint address>", where <endpoint address>" is the attribute 
specified in the <endpoint> tag within the "E5WindowsServer.config" file. 
The default endpoint addresses are: "/basic" , "/ws", "/netTcp" (for the three corresponding service 
types). 

So, according the resulting addresses to be used by the client software are: 

 for Basic HTTP binding  
http://myserver.myorg.com:8731/ECCAIRS5/basic  

 for Ws HTTP binding  
http://myserver.myorg.com:8731/ECCAIRS5/ws  

 for Net.TCP binding  
net.tcp://myserver.myorg.com:8735/ECCAIRS5/netTcp  

Where you have to substitute: 

 myserver.myorg.com with the specific network name of your Server. 

 8731 and/or 8735 with the specific alternate TCP port number you may have set. If you have not 
modified them in the "E5WindowsServer.config" file on the Server.  

Note down the address actually resulting for your specific installation in the "Summary of Options 
Installed - ECCAIRS 5 Server (Network-accessible)" form, printed from page 163. 

See Section "2.4.4 Connect to a Remote Server via Web Services", page 41, for details on how to set up 
an ECCAIRS client application (e.g. ECCAIRS Brower) to access the Server via Web Services. 
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3.7.2. CONFIGURE THE WINDOWS FIREWALL 

In order to allow remote Client connections towards the ECCAIRS Server, some configuration is required 
in the Windows Firewall. 

Two rules have to be created in order to make the system working properly: a rule for the Net.TCP, 
Basic HTTP, Ws HTTP ports chosen and a rule for the "E5WindowsService.exe" application. 

The following instructions refers to the Windows built-in Firewall in Windows 7/Windows Server 2008. 

If you use a third party software firewall or an hardware firewall instead, make sure that you perform 
equivalent settings. 

To setup the Web Service via Windows Service access firewall rules perform the following steps: 

1. Select "START > Control Panel > Windows Firewall". 
The main configuration window shows up. 

2. Click on the "Advanced Settings" option (on the left of the main configuration window of 
Windows Firewall). The "Advanced Security" windows shows up. 

3. Select the "Inbound Rules" node. 

 

4. ECCAIRS Programs rule 
Perform the following steps: 

 Click on the "New Rule "option on the top right corner of the Advanced Security window. 

 In the Rule Type "window, choose "Program" and click on "Next". 

 In the "Program" window: 

o Select the "This program path:" option. 

o Browse to the path where you have installed ECCAIRS (that you wrote down in the 
"Summary of Options Installed - ECCAIRS 5 Server (Network-accessible))" form, printed 
from page 163). 

o Select the "E5WindowsServer.exe" application and click on "Next.". 

 In the "Action" window leave the Allow the connection" option selected and click on "Next". 

 In the "Profile" window leave all the options ticked and click "Next". 

 Provide a name for the rule. 
Suggested name: "ECCAIRS Windows Service". 
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5. Create ECCAIRS Port rule 
Perform the following steps: 

 Click on the "New Rule" option on the top right corner of the Advanced Security window. 

 In the "Rule Type" windows choose "Port" and click on "Next". 

 In the "Protocol and Ports" window specify the TCP ports chosen for Net.TCP, Basic HTTP, 
Ws HTTP ports and click on "Next". 
For instance, in the sample TCP ports chosen in the previous section (see "3.7.1 Configure 
the Windows Service", page 70"), the ports to enable would be 8731 and 8735. 
You must use your specific ports, that you have previously noted in the "Summary of Options 
Installed - ECCAIRS 5 Server (Network-accessible)" form, printed from page 163. 

 In the "Action" window leave the "Allow the connection" option selected and click on 
"Next". 

 In the "Profile" window leave all the options ticked and click on "Next". 

 Provide a name for the rule. 
Suggested name: "ECCAIRS Web Services Ports". 

 

The new rules are enabled by default. 

 

3.7.3. START THE WINDOWS SERVICE 

Finally the service needs to be started performing the following steps: 

1. Select "START > Run" and enter services.msc 
The "services" window shows up. 

2. Select the "Eccairs 5 Repository Service Server" service and select "Right-click > Start". 

3. Select the "Eccairs 5 Repository Service Server" service and select "Right-click > 
Properties". 

4. In the dialog that shows up change set the "Startup Type" field to "Automatic" instead of 
"Manual". 

Once you have performed the steps described above it is possible to connect to the ECCAIRS 5 Server 
from a client machine through Web Services. 
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3.8. SETUP ACCESS VIA WEB SERVICES (BY IIS) 
A client can connect to the server using protocol types based on Web Services. 

A Web Service access can be provided in two different ways:  

 using IIS to host the Web Services, which is the subject of this Section. 

 using a Windows Service. 
See page 69, Section "3.7 Setup access via Web Services (by Windows Service)". 

In any case you can setup more than one access protocol on the same Server. 

 See page 63, Section "3.6 Setup access via DCOM". 

 See page 69, Section "3.7 Setup access via Web Services (by Windows Service)". 
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The Internet Information Services (IIS) hosting mode offers two already preconfigured service types, 
either in secure (https) or, in alternative, non-secure (http) version: 

 Basic http/https 

 Ws http/https 

You cannot configure and run at the same time both the non secured (http) and the secured (https) 
version of the web services. But you can run at the same time the Basic and Ws version of the protocol 

To host these ECCAIRS 5 Web Services inside IIS you have to perform the steps described in the 
following paragraphs. 

The setup requires to: 

 Create and configure the E5WebAdministrator user. 

o see page 133, Section "5.4.1 Create and configure the E5WebAdministrator User" 

 Setup IIS for the Web Services, which is different for the two current versions of IIS: 

o IIS6 - see page 75, Section "3.8.1 IIS 6 - setup for Web Services" 
(Windows XP, Windows 2003 Server). 

o IIS7 - see page 77, Section "3.8.2 IIS 7 - setup for Web Services" 
(Windows Vista, Windows 7, Windows 2008 Server). 

 Select the secure (https)/non-secure (http) configuration of the Web Services and 
customise it 

o See page 80, Section "3.8.3 Configure the Web Services". 

3.8.1. IIS 6 - SETUP FOR WEB SERVICES 

This section deals with the setup of IIS 6, which is the version of IIS which comes with Windows XP and 
Windows 2003 Server. Skip to Section "3.8.2 IIS 7 - setup for Web Services", page 77 for IIS 7. 

Before configuring make sure that IIS is installed/turned on, on the system. 

Additional setup for IIS 6 running on a 64-bit system 

If you are using IIS 6 on a 64-bit system, before proceeding you have to configure it to run 32-bit 
applications performing the following actions: 

1. Open a command prompt  

2. Navigate to the %systemdrive%\Inetpub\AdminScripts directory. 

3. Type the following command: 
cscript.exe adsutil.vbs set W3SVC/AppPools/Enable32BitAppOnWin64 “true”  

4. Press the ENTER key. 

Configure the Web Service in IIS 6 

With IIS 6 installed, the following steps are required: 

1. Select "START > Administrative Tools > Internet Information Services (IIS) manager". 

2. Select the "Application Pools" group and then the "Right-click > New > Application Pool" 
menu-item. 

3. Name "Eccairs Communication Pool" the new Application Pool. 

4. Select to "Default Web Site" in IIS and then the "Right click > Properties” menu-item. 
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5. The "Default Web Site Properties" dialog shows up. 

6. In the “Home Directory” tab and click on the “Configuration…" button. 
The "Application Configuration” dialog, shows up. 

7. In the Application extension check whether “.svc” extension exists. 
If it does not exist – click on the “Add…" button. 
In the “Add/Edit Application Extension Mapping” dialog that shows up set the following items: 

 Executable - click on the “Browse…” button to select the “aspnet_isapi.dll” 
(%WINDIR%\Microsoft.NET\Framework\v4.0.nnnnn\aspnet_isapi.dll). 
The nnnnn is a version number that may change along with Microsoft .NET updates. 

 Extension - enter: 
.svc 

 Verbs -  

o Select the option “Limit to”: 

o Enter the following: “GET, HEAD, POST, DEBUG”. 

 Click on "OK" to close the "Add/Edit Application Extension Mapping" dialog. 

8. Back in the "Application Configuration" dialog click on "OK" to close it. 

9. Back in the "Default Web Site Properties" dialog click on "OK" to close it. 

10. Select your "local server" node, then the "Default Web Site" node, then select "Right-click > 
New > Virtual Directory". 

 Choose an Alias for your virtual directory: default alias to be set is eccairs5. 
Note it down in the "Summary of Options Installed - ECCAIRS 5 Server (Network-accessible)" 
form, printed from page 163. 
Also remember that this name has to be coherent with the name that you will set in the 
"baseAddress" node within defined "web.config" file, see page 80, Section "3.8.3 
Configure the Web Services". 

 Click on "Next". 

 Set the path for the virtual directory the ECCAIRS 5 installation folder, normally C:\Program 
Files\ECCAIRS5. 
In any case the actual installation folder location is the one that you wrote down on the 
"Summary of Options Installed - ECCAIRS 5 Server (Network-accessible)" form, printed from 
page 163. 

 Click on the "Next" button and assign "Read and Run scripts" permissions. 

 Click on the "Next" button to complete the creation of the virtual directory. 

11. Select the virtual directory you have just created and then "Right-Click > Properties" menu-
item. The "Properties" dialog shows up. 

 In the "Virtual Directory" tab of the "Properties" dialog assign the "Eccairs 
Communication Pool" to the virtual directory. 

 In the "ASP.NET" tab of the "Properties" dialog select "4.0.30319" as "ASP.NET Version". 
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3.8.2. IIS 7 - SETUP FOR WEB SERVICES 

This section deals with the setup of IIS 7, which is the version of IIS which comes with Windows Vista, 
Windows 7 and Windows 2008 Server. If you have IIS 6.refer to Section "3.8.1 IIS 6 - setup for Web 
Services", page 75. 

Before configuring make sure that IIS is installed/turned on, on the system. 

The following Server Role must be enabled:  

 Web Server (IIS) 

The following Role Services must be enabled:  

 Common HTTP features: 

 Default Document 

 Application Development features: 

 ASP.Net  

 Security features: 

 Basic Authentication 

 Windows Authentication 

 Performance features: 

 Static Content Compression 

 Dynamic Content Compression 

Configure the Web Service in IIS 7 

With IIS 7 installed, the following steps are required: 

1. Select "START > Administrative Tools > Internet Information Services (IIS) manager". 

2. Select the "Application Pools" node in the left panel of the IIS Manager under your local 
computer name and then the "Right-click > Add Application Pool…" menu-item. 

3. An "Edit Application Pool" dialog shows up. 
Perform the following steps: 

 Name - enter "Eccairs Communication Pool". as the new pool name. 

 NET Framework version: - select ".NET Framework v4.n.nnnnn" from the drop-down list, 
where the n.nnnnn digits identify the specific subversion of the .NET Framework 4 installed 
on your computer. 

 Managed Pipeline Mode - select "Classic" from the drop-down list. 

 Start application pool immediately - select this check-box. 

 Click on "OK" to confirm and close the "Edit Application Pool" dialog. 

4. Select "Eccairs Communication Pool" in the central panel of the IIS Manager and then "Right-
click > Advanced Settings". 

5. The "Advanced Settings" dialog shows up. 
Perform the following steps: 

 (only for 64 bit Operating Systems) 
In the "(General)" section set “Enable 32-Bit Applications” as "True". 
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 In the "(Process Model)" section set the "Identify" by clicking on the "..." button on its right. 

 An "Application Pool Identity" dialog shows up. 

 Select "Built-in account" radio-button. 

 Select "LocalSystem" from the drop-down list 

 Click on "OK" to confirm and close the "Application Pool Identity" dialog and you get back 
to the "Advanced Settings" dialog. 

 Click on "OK" to confirm and close the "Advanced Settings" dialog. 

6. Select your "local computer name > Sites > Default Web Site" node in the left panel of the IIS 
Manager. 

7. Within the IIS Manager central panel (now showing "Default Web Site Home"), double-click on 
"Handler mappings". 
The central panel is by default in the "Features View" mode and lists the current Handlers 
Mappings. If not, check that the "Features View" is actually selected in the bottom of the central 
IIS Manager panel. 

8. In the list of Handlers Mappings shown, verify that the ".svc" file extension is mapped to the 
aspnet_isapi.dll. 
If the file has not been mapped: 

 Within the IIS Manager right panel click on "Add Managed Handler" (or "Right-click > Add 
Managed Handler" in the central IIS Manager panel). 
An "Add Managed Handler" dialog shows up. Perform the following steps: 

o Request path: - enter: 
*.svc 

o Type - enter: 
System.ServiceModel.Activation.HttpHandler, System.ServiceModel, 
Version=3.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089 

o Name: - enter: 
svc-Integrated 

o Click on "OK" to confirm and close the "Add Managed Handler" dialog. 

 Within the IIS Manager right panel click on "Add Script Map" (or "Right-click > Add Script 
Map" in the central IIS Manager panel). 
An "Add Script Map" dialog shows up. Perform the following steps: 

o Request path: - enter: 
*.svc 

o Executable: - enter: 
%SystemRoot%\Microsoft.NET\Framework\v4.0.nnnnn\aspnet_isapi.dll  
The nnnnn is a version number that may change along with Microsoft .NET updates. 

o Name: - enter: 
svc-ISAPI-4.0 

o Click on "OK" to confirm and close the "Add Script Map" dialog. 

9. Within the IIS Manager left panel select the "Default Web Site" node under your local server 
node, and then select the "Right-click > Add Application" menu-item. 

10. The "Add Application" dialog shows up. Perform the following steps: 

 Alias: - choose an Alias for the application, for instance eccairs5. 
Note it down in the "Summary of Options Installed - ECCAIRS 5 Server (Network-accessible)" 
form, printed from page 163. 
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Remember that this name has to be the same name that you will set in the "baseAddress" 
node in the "web.config" file (disable the read-only attribute to the file before changing it), 
see page 80, Section "3.8.3 Configure the Web Services". 

 Application pool - click on the "Select" button and in the "Select Application Pool" dialog 
that shows up select the "Eccairs Communication Pool" from the drop-down list. 

 Physical path - use the "..." button and browse dialog to select the ECCAIRS 5 installation 
folder, normally C:\Program Files\ECCAIRS5 for 32 bit systems. 
In any case the actual installation folder location is the one that you wrote down on the 
"Summary of Options Installed - ECCAIRS 5 Server (Network-accessible)" form, from page 
163. 

11. Click on the "Connect As…" button, and in the "Connect As" dialog that opens, select "Specific 
User". 

12. In the "Set Credentials" dialogs provide the "E5WebAdministrator" credentials and click on "OK" 
to confirm and close both the "Set Credentials" and "Connect As" dialogs. 

13. Before confirming and closing the "Add Application" dialog with the "OK" button, we suggest to 
use the "Test Settings…" button check the configuration. 

14. Exit the IIS Manager. 
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3.8.3. CONFIGURE THE WEB SERVICES 

Preliminary step only needed to use the web services over the https secure protocol 

The very first choice you have to make is which version of security you want to use for the web services 
protocol. You can use either the standard http protocol or the https secure version, both not both. 

If you want to use web services over the secured https protocol, then you need to use a specific https 
version of the Web Services configuration file, in place of the standard configuration file available by 
default. 

So, only if you will be using the https secured web-services, perform the following steps: 

1. Open a file browser window and go to the  ECCAIRS 5 installation folder. 
The installation folder location is written down in the "Summary of Options Installed - ECCAIRS 5 
Server (Network-accessible)" form, printed from page 163.  
In any case the installation folder is by default the "Eccairs 5" sub-folder either inside the 
"Program Files" folder of the system disk (the C: drive normally) or, for 64 bit version of Windows, 
inside the "Program File (x86)" folder. 

2. Inside the Eccairs 5 installation folder you find two versions of the web services configuration file:   

 "web.config" is the version pre- configured for the http protocol. 

 "web-https.config" is the version pre-configured for the https, the http secure protocol. 

Whatever http variant you need, ECCAIRS will search for a configuration file named "web.config". 

3. Rename the original http-based "web.config" file to "web-http.config". 

4. Copy and paste in place the "web-https.config" file, and reaname the copy to 
"web.config". 
Now the "web.config" file content is the https version of it. 

If you will ever need to go back to the non-secure version, you can use and copy/rename the saved  
"web-http.config" file. 

Set the actual Server address and Web Service alias in the configuration file 

You have to open the "web.config" file located in the ECCAIRS 5 installation folder, using Windows 
Notepad or any other program which can open and edit plain text files. 
The ECCAIRS 5 installation folder location is written down in the "Summary of Options Installed - 
ECCAIRS 5 Server (Network-accessible)" form, printed from page 163. 

The "baseAddresses" node in the file contains: 

      <baseAddresses> 

          <add baseAddress="http://localhost/eccairs5" /> 

      </baseAddresses> 

This means that the default Server net name specified in the "web.config" file is "localhost" and the 
default Web Service alias is "eccairs5", and under the "baseAddress" node you find both of them 
combined in a single line: 

If you have set an Alias name for the Web Service, different form the suggested "eccairs5" (in either 
Section "3.8.1 IIS 6 - setup for Web Services" or Section "3.8.2 IIS 7 - setup for Web Services" ) then 
you have to use that in place of "eccairs5" in "http://localhost/eccairs5". 
If you have followed the instructions in this manual, you will find the Alias you have set for the Web 
Service noted down in the ALIAS field in the "Ws HTTP(S) / Basic HTTP (S) NETWORK ACCESS (via 
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IIS)" section of the "Summary of Options Installed - ECCAIRS 5 Server (Network-accessible)" form, 
printed from page 163. 

So, if you have set "mywebservicealias" as Alias name in IIS for the Web Service (instead of the default 
"eccairs5"), then the line should be: 

          <add baseAddress="http://localhost/mywebservicealias" /> 

After any changes in "web.config" file you have to stop and start IIS in order to apply the 
modifications. 

The resulting complete Web Service addresses 

In the same  "web.config" file you find two "endpoint" nodes, corresponding to the Ws and Basic 
Web Service protocol types. 

   <endpoint address="/ws" 

      etc etc... /> 

   <endpoint address="/basic" 

      etc etc />         

Their "address" property will form the tail of the complete Web Service address needed to be entered in 
an ECCAIRS client login to access the Server via Web Services protocols. See page 43, Section "2.4.5 
Connect to a Remote Server via https Web Services". 

So, in principle you could also change the names used in the "endpoint address" property in the 
"web.config" file, and change accordingly the resulting complete Web Service addresses. 

In the https secured version of the "web.config" file the two "endpoint" nodes have different 
"address" properties: 

   <endpoint address="/ws-https" 

      etc etc /> 

   <endpoint address="/basic-https" 

      etc etc /> 

For instance, the resulting complete Web Service addresses, when using "eccairs5" as Web Service 
application Alias (the default suggested), would be: 

 for Basic HTTP binding  
http://myserver.myorg.com/eccairs5/service.svc/basic  

 for Ws HTTP binding  
http://myserver.myorg.com/eccairs5/service.svc/ws  

Or, in alternative, when the https protocol has been selected and configured for ECCAIRS Web 
Services: 

 for Basic HTTPS binding  
https://myserver.myorg.com/eccairs5/service.svc/basic-https 

 for Ws HTTPS binding  
https://myserver.myorg.com/eccairs5/service.svc/ws-https  

Whatever Web Access service access address you have obtained in your specific installation, note them 
down in the corresponding fields in the "Summary of Options Installed - ECCAIRS 5 Server (Network-
accessible)" form, printed from page 163: 

 Section "Ws HTTP / Basic HTTP NETWORK ACCESS (via IIS)"  

Or, in alternative, when the https protocol has been selected and configured for ECCAIRS Web 
Services: 



SERVER INSTALLATION SETUP ACCESS VIA WEB SERVICES (BY IIS) 
 

 

82 

 Section "Ws HTTPS / Basic HTTPS NETWORK ACCESS (via IIS)". 

3.8.4. CONFIGURE IIS FOR HTTPS WEB SERVICES (ONLY FOR THE HTTPS 
SECURE MODE) 

This step is required only if you are setting up IIS and the ECCAIRS Web Services for the secure 
protocol version (https).  
In this case make sure that you have previously selected and customised the secure version of the 
"web.config" file. See page 80, Section "3.8.3 Configure the Web Services". 

All the steps are performed using the IIS Manager tool. To start it: 

 Select "START > Administrative Tools > Internet Information Services (IIS) manager". 

Create or Import a Server Certificate 

The first step is to create or import a "server certificate" that is needed to use the SSL security layer. 

You can create a self-signed certificate for test runs, but if you plan to use the Server over Internet with a 
reliable security, you should use a proper "public key certificate" released by a Certification Authority. 

As a reference we describe here how to create and use a self-signed certificate. 

Perform the following steps: 

1. In the left panel of the IIS Manager select the node corresponding to the Web Server instance 
you are working on.  
In most cases you only have one Web Server instance, identified with the network name of the 
Server computer itself, and it is selected by default. 

 

2. Click the "Server Certificates" icon in the central panel. 
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3. If you want to create a self-signed certificate: 

 In the certificate actions panel on the right select "Create Self-Signed Certificate". 

 Give a meaningful name to the certificate file. 

 

4. If, alternatively, you already have a certificate but you have not used it yet with IIS: 

 In the certificate actions panel on the right select "Import". 

 In the dialog box which shows up you can locate and specify the certificate file.  
The file has a .pfx extension. 
If the certificate has been secured with a password, you also have to enter it. 

 



SERVER INSTALLATION SETUP ACCESS VIA WEB SERVICES (BY IIS) 
 

 

84 

5. The newly created or imported certificate is now listed in the central panel, along with other ones 
possibly present. 

 

Setup IIS for https 

Now we set up IIS to handle the https protocol. 

1. In the left panel of the IIS Manager select the "Site" parent node of the web application whose 
name you have set up in the "web.config" file in the <baseAddresses> node (by default 
"eccairs5"). See page 80, Section "3.8.3 Configure the Web Services" for details. 
In most cases the parent site is the "Default Web Site" node, and you just select it, i.e. select your 
"local computer name > Sites > Default Web Site" node in the left. 

2. select "bindings" inside the actions panel on the right panel. 
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3. check that "https" is listed in the "Site Bindings" dialog that shows up.  

4. If "https" is already defined, then select it from the list and click on the "Edit" button. 

 

5. If "https" is not yet defined, then Click the "Add" button. 

 

6. Either the "Edit Site Binding" or "Add Site Binding" dialog pops up. 

 

7. If you are in "Add Site Binding", select "https" in the "Type" drop-down list. 

8. In both the "Edit Site Binding" and "Add Site Binding" dialog you can: 

 Change the https IP port, 443 by default, or specify the IP address to which https is bound. 

 Select the proper "SSL certificate". 
If we had created or imported only one "Server Certificate", then it is the one used by default 
as SSL certificate.  
If we had created or imported more then one, then we must select the suitable one form the 
drop-down list at the bottom.  

 Click on "OK" to confirm the changes and close the dialog. 
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9. Once the https binding has been edited of added, we click on the "close" button to exit the "Site 
Bindings" dialog. 

 

Require SSL for the Web Service 

 

1. Select your "local computer name > Sites > Default Web Site > eccairs5" node in the left . 
This works for most cases since "eccairs5", the default "Site" web application child node of the 
single "Default Web Site" defined.   
If you have set an Alias name for the Web Service, different form the suggested "eccairs5" (in 
either Section "3.8.1 IIS 6 - setup for Web Services" or Section "3.8.2 IIS 7 - setup for Web 
Services" ) then you have to use that in place of "eccairs5" in "http://localhost/eccairs5". 
If you have followed the instructions in this manual, you will find the Alias you have set for the 
Web Service noted down in the ALIAS field in the "Ws HTTP(S) / Basic HTTP (S) NETWORK 
ACCESS (via IIS)" section of the "Summary of Options Installed - ECCAIRS 5 Server (Network-
accessible)" form, printed from page 163. 

2. Then click on the "SSL Settings" icon in the central panel.  
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3. Select the "Require SSL" option in the "SSL Settings" central panel. 

4. Leave the "Client certificates" radio-button in the default "Ignore" option.  

5. Click on "Apply" in the Action panel on the right. 

Test the Web Service mechanism access 

To test the overall settings: 

1. Open a Browser, e.g. Internet Explorer. 

2. Type in an URL structured like this: https://myserver.myorg.com/eccairs5/service.svc 
where myserver.myorg.com is the address, which is either: 

 - the network Server name, in a LAN environment, or  

 - the Server FQDN over Internet, e.g. eccairs.docaware.org . 

This works for most cases since "eccairs5" is the default "Site" web application child node of the 
single "Default Web Site" defined.  
If you have set an Alias name for the Web Service, different form the suggested "eccairs5" (in 
either Section "3.8.1 IIS 6 - setup for Web Services" or Section "3.8.2 IIS 7 - setup for Web 
Services" ) then you have to use that in place of "eccairs5". 
If you have followed the instructions in this manual, you will find the Alias you have set for the 
Web Service noted down in the ALIAS field in the "Ws HTTP(S) / Basic HTTP (S) NETWORK 
ACCESS (via IIS)" section of the "Summary of Options Installed - ECCAIRS 5 Server (Network-
accessible)" form, printed from page 163. 
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3. If everything is set correctly you get a "erssSrvConnector Service" web page that displays some 
general information on how to call a web service. 
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3.9. TASKS NEEDED TO OPERATE THE SERVER 
Once you have performed the ECCAIRS 5 Server installation and configured the connection protocols to 
communicate with Clients, you need to perform a number of other "side" installations and/or 
configurations regarding the specific Taxonomy to use and the Repositories to be deployed on the 
Server. 

These mandatory tasks and setups must be performed in the order displayed here. 

_____________________________________________________________________________  

 INSTALL AN EXTENSION 
See page 91, Section "3.10 Install an Extension", for instructions. 

The ECCAIRS Common Framework Server is the core of the ECCAIRS Server, but still need to 
be specialised for specific environments, e.g. Aviation, EMCIP/EMSA, etc. 
The specific extension installs and provides the corresponding Taxonomy files, Views, Repository 
profiles and database generation scripts. 

_____________________________________________________________________________  

 SETUP OCCURRENCE DATABASE  
See page 96, Section "3.11 Setup Occurrence databases" for instructions. 

The ECCAIRS 5 system stores Occurrences and Attachments in a database. The database can 
reside on a RDBMS in the same computer as the ECCAIRS 5 Server or in any other network 
accessible computer. 
Microsoft SQL Server and Oracle RDBMS area supported and specific setup procedures are 
given. 

_____________________________________________________________________________  

 CREATE A REPOSITORY 
See page 104, Section "3.12 Setup Repositories" for instructions. 

The Repository is the centre of the local ECCAIRS network: all Client applications must use it for 
being able to input, retrieve and display Occurrence data. The role of the Repository is managing 
Occurrence data by means of security, data display rules and data access configuration. 
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The following diagram summarise the steps. 
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3.10. INSTALL AN EXTENSION 

 

The ECCAIRS Server and it is not yet bound to any specific application domain. It must be combined 
with a specific Extension (e.g. Aviation, Maritime EMCIP/EMSA, etc) to complete the system setup. 

An ECCAIRS Extension provides, for a specific application domain: 

1. Database scripts. 

2. Taxonomy files: logical Dictionary and physical Dictionary. 

3. Repository Profiles, divided by different categories. 

4. Views. 
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3.10.1. EXTENSION FILES AND FOLDERS 

The Extension, once installed, is a collection of different type of files that you will use to set up ECCAIRS 
Repositories and databases suited to specific ECCAIRS application domains. Each category of files is 
stored in a specific subfolder of the Extension main folder. 

The Extension main folder has an Extension-domain specific name: for instance AVIATION for the 
Aviation Extension, EMCIP for the Maritime Extension, etc.  
The Extension main folder is the same for any release of that Extension: All the folder and files of a type 
of Extension, whatever its release, are always installed inside the same folder and subfolders.  

The Extension folder is created into the folder: 

 (in 32 bit systems) 
C:\Program Files\ECCAIRS5\Extensions\ 

 (in 64 bit systems). 
C:\Program Files (x86)\ECCAIRS5\Extensions\ 

For instance the EMCIP Maritime extension in a 32 bit system is installed in Subfolder: 

C:\Program Files\ECCAIRS5\Extensions\EMCIP 

If you do not have a previous release of the same Extension installed, then you can skip the following 
Section and install the Extension. 

3.10.2. MORE VERSIONS OF THE SAME EXTENSION INSTALLED 

More versions of the same Extension can co-exist. However, since the Extension main folder is the 
same for all releases, some of the files with the same name might get overwritten, while others not, 
possibly making the Extension folder content inconsistent.  

So we suggest, in the "Programs and Features" item of the Windows Control Panel, to keep only one 
version of the same Extension and uninstall all the others.  

Uninstalling an Extension just removes the files installed in its specific Subfolder. Nothing is affected in 
the Occurrence database, in the Repositories or anywhere else. So you can easily back up its content 
before uninstalling it. 
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You can find out if you have more releases of the same Extension looking at the "Version" column in the 
"Programs and Features" item of the Windows Control Panel.  

Back up an Extension 

If you are using Repositories and/or databases created with previously installed versions of the 
Extension, you can make and keep a backup copy of the Extension Subfolder before uninstalling. 

Just copy the entire Subfolder into another one with a meaningful name. It might be a good idea to keep 
this backup folder in the ECCAIRS Extension Subfolder. 
For instance, on backing up Aviation extension version 1111 before uninstalling and upgrading to the 
newer version, you can copy the folder: 
C:\Program Files\ECCAIRS5\Extensions\Aviation 
into the folder: 
C:\Program Files\ECCAIRS5\Extensions\Aviation_1111 

Uninstall an Extension 

You uninstall the Extension using the standard Windows system "Programs and Features" item, started 
form the Control Panel. 

 

In the "Version" column in the "Programs and Features" window you can check the Extension version 
you are about to uninstall. 
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3.10.3. INSTALL AN EXTENSION 

Extensions come as a single distributable setup file, available as a download from the ECCAIRS portal. 

To install the Extension: 

5. Execute the Extension distribution file, for instance E5AEDistributionV1111.exe, to extract 
the actual setup files. 
You have to specify a folder where the setup files will be put or accept the default. 

 

6. Once the distribution package has been expanded, the "Release Notes" PDF document is 
automatically displayed (if you a have a PDF reader installed). 
Read carefully this document, since it contains important content, compatibility and installation 
information.  

 

7. The folder where the distribution package has been expanded contains the Extension setup file. 
Execute the setup file. For example E5AESetupV1111.exe. 
The Welcome screen of the installation wizard is displayed. 
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8. Click "Next" to get to the "Accept License" step. You have to choose explicitly the "I Accept the 
terms of the license agreement" option and then click "Next" to continue. 

9. In the "Customer Information" step keep the default option choice to "Anyone who uses this 
computer (all users)". Click "Next" to continue. 

10. Keep clicking "Next" till you get to the "Ready to Install the Program" step and click "Install". 
Before this step you can always click "Back" to revise the previous steps or "Cancel" to abort the 
installation.  

11. Once installation is over, click the "Finish" button to exit the installation wizard. 

12. The Extension files are installed into the folder: 

 (in 32 bit systems) 
C:\Program Files\ECCAIRS5\Extensions\<Extension Name> 

 (in 64 bit systems). 
C:\Program Files (x86)\ECCAIRS5\Extensions\<Extension Name> 

The files are stored into different subfolders in the <Extension Name> main folder. 

 

The Documents folder contains a copy of the important "Release Notes" PDF document and 
other useful documents. 

The other folders are used in the next configurations steps. 
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3.11. SETUP OCCURRENCE DATABASES 

 

 

 

The ECCAIRS 5 system stores Occurrences and their Attachments in a database. 

The database structure is dependent on the application-domain Taxonomy (e.g. Aviation, EMCIP 
Maritime, SRIS, etc). Installing the corresponding Extension you get the database scripts needed to 
create all the tables needed. 
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The database can reside on a RDBMS in the same computer as the ECCAIRS 5 Server or in any other 
network accessible computer. 

 

ECCAIRS 5 Server and Occurrence database on the same computer 

 

 

ECCAIRS 5 Server and Occurrence database on separate computers 
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Two types of RDBMS are supported, and separate configuration instructions are given: 

 Oracle 10.2 or higher. 

 Microsoft SQL Server 2005 or higher. 

If you are installing ECCAIRS Server as upgrade to a previous release, then read carefully the new 
version Release Notes document to see if there are specific actions to perform or compatibility issues 
with databases. 

Database space required 

In the following Subsections you find the initial space to allocate for the database elements.  
The size of each table will grow with time, according to the amount of data entered. The growth cannot 
be estimated here, since it depends on a number of factors which are installation and usage specific: the 
Taxonomy in use (application domain), the average amount of information entered per Occurrence, the 
number and average size of attachments, etc.  
For instance, in the Aviation application domain, an average Occurrence uses up to 300 kB of database 
storage space, without taking into account possible attachments. 

3.11.1. SEPARATE ATTACHMENT DATABASE 

Occurrences and their Attachments are normally stored in the same database.  

If you need to host the Attachments in a separate database, you just have to create another database, 
identical to an Occurrence database, but with a different name and/or on a different RDBMS. So you can 
follow the instructions given in the next Sections for the Occurrence database, possibly using a suitable 
name for an Attachments dedicated database. 

Then, on configuring the Repository, in the "Attachment configuration" node, you select "Database" from 
the "Connection type" drop-down list and fill the suitable "Database connection" parameters for the 
Attachment database you have created. 

3.11.2. DATABASE CONFIGURATION (ORACLE) 

In order to use ECCAIRS 5 with an Oracle Database, the following components are required: 

 Oracle Client 10.2 (or higher) including the following modules: 

 Oracle Windows Interfaces. 

 Oracle Provider for OLE DB. 

 Oracle Net. 

Using the appropriate database management tools provided by Oracle perform the following 
configurations. 

The database you create must be Case-Insensitive. 

3.11.2.1. TABLESPACES AND VOLUMES 

The following tablespaces and volumes are required. 

Tablespace Tablespace Name Initial size

Data  ECCAIRS5_DATA 200 MB 
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Data  ECCAIRS5_ATTACHMENT 10 MB 

Data  ECCAIRS5_BACKUP 10 MB 

Index  ECCAIRS5_INDEX 100 MB 

Blob  ECCAIRS5_BLOB 200 MB 

Blob  ECCAIRS5_ATTACHMENT_BLOB 200 MB 

Blob  ECCAIRS5_BACKUP_BLOB 500 MB 

User default ECCAIRS5_DEFAULT 300MB 

In case you have problems in creating the Tablespaces above, contact the JRC ECCAIRS Coordination 
and Development for support. 

3.11.2.2. CREATE THE SCHEMA OWNER 
To create the Schema Owner, create a user with the following settings: 

Schema owner: <SCHEMA_OWNER> 

Password: to be defined 

Default tablespace: ECCAIRS5_DEFAULT 

Temporary tablespace System default or any other temporary tablespace 

Role grants: Connect, Resource 

System Privileges 
Create view, create procedure, create sequence, create 
session, create table, create trigger, create type 

Quotas unlimited quotas on ECCAIRS5_DEFAULT 

unlimited quotas on ECCAIRS5_ATTACHMENT 

unlimited quotas on ECCAIRS5_ATTACHMENT_BLOB 

unlimited quotas on ECCAIRS5_BACKUP 

unlimited quotas on ECCAIRS5_BACKUP_BLOB 

unlimited quotas on ECCAIRS5_ BLOB 

unlimited quotas on ECCAIRS5_DATA 

unlimited quotas on ECCAIRS5_INDEX 

3.11.2.3. CREATE THE DATABASE SCHEMA 
When you install an Extension, the corresponding “Make ORACLE Using Sets.sql” database/tables 
setup script is copied in folder: 
 <Extension Install Dir>\Database Scripts. 

The <Extension Install Dir> folder is by default: 
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  (in 32 bit systems) 
C:\Program Files\ECCAIRS5\Extensions\<Extension Name> 

 (in 64 bit systems). 
C:\Program Files (x86)\ECCAIRS5\Extensions\<Extension Name> 

 If you have changed the Extension installation folder, you should have written its full path in 
the "Server Installation Summary" form (page 159 for stand-alone Server or page 163 for 
network-accessible Server). 

Do the following: 

1. Use the appropriate database management tools provided by Oracle and connect as 
<Schema_Owner> user. 

2. Execute the “Make <Taxonomy Name> <Taxonomy Version> ORACLE.sql” script.  
For instance "Make ECCAIRS Aviation 1.3.0.8 ORACLE.sql" in the Aviation extension 
version 1.1.0.8.  
Earlier versions of Extensions may not include the Taxonomy version in the script name. 

 

3. Verify that the script executes successfully. If not, contact the JRC ECCAIRS Coordination and 
Development for support.. 
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3.11.3. OCCURRENCE DATABASE CONFIGURATION (SQL SERVER)  

This Section contains specific instructions for setting up an ECCAIRS database running on Microsoft 
SQL Server, version 2005 onwards. We assume that either release of SQL Server has been installed 
prior to following the instructions. 

3.11.3.1. CREATE THE DATABASE AND USER 
Perform the following steps: 

4. Connect to a SQL Server instance with a user with sufficient privileges to create a database. 
Make sure that the SQL Server instance supports SqlServer authentication. 

5. Create a new database. This brings up the dialog where you can set all properties for the new 
database and its transaction log.  
The database you create must be Case-Insensitive. See the dedicated Section further on. 

6. Enter a suitable name for the database in the properties dialog, for instance ‘E5DB’.  

7. Configure the data files and set the size of the database file to meet your requirements. 
The settings for "File growth" and "Maximum file size" must be established according to the 
proper database policy. Confirm all the settings done. 

8. Create a new database user for the ECCAIRS database just created and set the authentication to 
"SQL Server authentication".  
Assign to this user the “dbowner” privilege on the ECCAIRS database. 

9. Note down in your "Configuration Form": 

 database Server name - the name with which the database Server is reachable from the ECF 
Server. E.g. its network name or an IP address. This may also include the database instance, 
e.g. dbservername\sqlexpress in case of SQL Server Express edition. 

 database name  

 database user 

 database user password 

3.11.3.2. CREATE THE DATABASE TABLES 
When you install an Extension, the corresponding database/tables setup scripts are copied in folder: 
 <Extension Install Dir>\Database Scripts. 
The <Extension Install Dir> folder is by default: 

  (in 32 bit systems) 
C:\Program Files\ECCAIRS5\Extensions\<Extension Name> 

 (in 64 bit systems). 
C:\Program Files (x86)\ECCAIRS5\Extensions\<Extension Name> 

 If you have changed the Extension installation folder, you should have written its full path in 
the "Server Installation Summary" form (page 159 for stand-alone Server or page 163 for 
network-accessible Server). 

To create the ECCAIRS database tables, keys, etc, do the following: 

1. Connect to a SQL Server Instance as user created with “dbowner” privilege on the ECCAIRS 
database and select it. 

2. Load the SQL script from <database Scripts> folder. 
The script name is in the form "Make <Taxonomy Name> <Taxonomy Version> <Sql 
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Server version>.sql" . For instance "Make ECCAIRS Aviation 1.3.0.8 Sql Server 
2005-2008.sql".  

 

3. Execute the script. 
Running the script may take several minutes. 

4. Verify that the script executes successfully. If not, contact the JRC ECCAIRS Coordination and 
Development for support. 

 

3.11.3.3. CASE INSENSITIVE DATABASE IN SQL SERVER 

A SQL Server instance may create Case Insensitive databases by default, depending on the 
configuration set at installation time. 

You can check this using your database management tool, e.g. the SQL Server Management Studio, 
and examining the "Server Collation" property.  

 

If the Server Collation has the "CI" string in its name, than the databases are created by default Case 
Insensitive. 

If not, when you create an ECCAIRS database, go into its Options page and select in its "Collation" drop-
down list one for whatever language and options you need, but make sure it includes the "CI" string into 
its name. 
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3.12. SETUP REPOSITORIES 

 

The Repository is the centre of the local ECCAIRS network: all Client applications must use it for being 
able to input, retrieve and display Occurrence data. 

The role of the Repository is managing Occurrence data by means of security, data display rules and 
data access configuration. A Repository is based on a specific Taxonomy and includes several types of 
Profiles, including the Views that can be used to organise the Occurrence data display and entry. 

Taxonomies, Profiles and Views are stored in and installed by specific Extensions and this is why you 
need to have the suitable Extension installed before setting up Repositories. 

3.12.1. OBTAIN AN ORGANISATION ID 

In order to create and configure a Repository, it is necessary to obtain an Organisation ID, which is 
required by the Repository Manager. 

You have to request your Organisation ID to the JRC ECCAIRS Co-ordination Centre. 

You can send an email to eccairs@jrc.ec.europa.eu to obtain an organisation ID. 
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3.12.2. CREATE AND CONFIGURE A REPOSITORY 

This Section describes only the essential operations required to create a Repository 

You can find more options and information inside the "Repository Manager" application documentation. 

Many of the following steps mention folders and files located in the <Extension Install Dir>, the folder 
where the suitable Extension has been installed. 
The Extension installation folder is by default: 

  (in 32 bit systems) 
C:\Program Files\ECCAIRS5\Extensions\<Extension Name> 

 (in 64 bit systems). 
C:\Program Files (x86)\ECCAIRS5\Extensions\<Extension Name> 

 If you have installed the Extension in another folder, while installing you should have written 
its full path in the "Server Installation Summary" form (page 159 for stand-alone Server or 
page 163 for network-accessible Server). 

To configure a Repository proceed as follows: 

1. Run the "ECCAIRS Repository Manager" application. 
Select "START > All Applications > Eccairs 5 > Administration > Repository Manager". 
The Repository Server you are connecting to is normally the local one, i.e. you are running the 
"Repository Manager" from the Server itself. So select "Local server" as Protocol type. 

 

Create or restore a Repository 

2. Create a new Repository  
Select "Add a new Repository" in the dialog displayed when you start the "Repository Manager" 
with no Repositories yet defined. You can always invoke this function selecting the 
"Repository > Add" menu-item. 

 

3. Restoring backed up Repositories (only after upgrade or reinstall) 
If you have any Repository backup to restore, you will instead select "Import a Repository from an 
exported file" or select the "Repository > Import" menu-item. If you restore a Repository and you 
have not modified the database or its access parameters, then you have nothing else to do.  
If you are actually installing the ECCAIRS Server as upgrade to a previous release or porting 
Repositories on a different Server, then read carefully the Server and the Extension Release 
Notes document to see if there are specific actions to perform or compatibility issues. 

mk:@MSITStore:C:\Users\enzo\Desktop\E5RepositoryManager.chm::/12_Menus/02_Repository/00__Repository_menu.htm#Add�
mk:@MSITStore:C:\Users\enzo\Desktop\E5RepositoryManager.chm::/12_Menus/02_Repository/00__Repository_menu.htm#Add�
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4. Repository tree 
A new Repository properties-tree is shown in the central panel. Property nodes that must be 
mandatorily set are marked in red colour. 
Select a node in the properties-tree to display its properties in the right panel. The Repository 
root node properties are displayed every time you select that Repository in the left panel. 

 

5. Whenever you make changes to these nodes you need to confirm them before being able to 
work on any other item of the Repository ("Toolbar > Update" icon-button). If not you get a dialog 
which prompts you to do so. 

Set the Repository core properties 

6. REPOSITORY ROOT NODE - click on the Repository root node in the central panel and set: 

 Name, Description and Password - the "Name" is mandatory: the default is 
"REPOSITORY". Set a more descriptive name. 
You can optionally enter a "Description" and define a password to edit the Repository in the 
subsequent accesses with the "Repository Manager". 
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 Organisation identification - use the "Organisation Identification" previously obtained from 
the JRC (see previous Section). 

 

 Has database - choose "Yes, uses a RDBMS" option. Otherwise you will not be able to 
access the Occurrence database.  

 Published - the "Yes, access allowed" option is active by default and you should leave it as 
it is. If not the Repository will not be available for use. 
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 Database connection - when you click the "Database Connection" icon-button a dialog 
shows up.  

 

You have to provide the connection and access parameters of the database where ECCAIRS 
data is stored. The data varies slightly according to the "Database Type" that you select. 
You can retrieve these data from your "Configuration Form", filled when creating the 
database. 

o Description - enter a description. 

o Database type - select the RDBMS type. 

o Username - the User name to log on to the RDBMS server. 

o Password - the corresponding User password. 

o Server name/Service name - the SQL Server database Server instance name or Oracle 
Service name. 

o Database name - (only for SQL Server) the database name. 

You may click the "Test" button to verify that the database connection works. You get a 
message box with the result and the connection parameters used. 
Then click "OK" to close the "Database Connection" dialog. 

 Indexing - the "Immediate" option is active by default and you should leave it as it is. The 
other option is for particular uses and requires also an optional service configuration.  
See page117, Section "4.3 Postponed Indexing".  

 Automatic backup enabled - choose "No" for this simplified settings. This is an optional 
feature that makes ECCAIRS store additional copies of any Occurrence changed or deleted 
into a specific backup table in the Occurrence database. This option must be combined with 
the "ECCAIRS Backup Service" periodically retrieves them from the backup table and 
move/copy them into a folder in the Server file system. See page 116, Section "4.2 Automatic 
Backup". 
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 Other options - all the other options may be left at their default status for the scope of this 
essential description. For more information refer to the "Repository Manager" documentation, 
where all the options are described in detail. 

Specify the Taxonomy that qualifies your application domain  

7. TAXONOMY NODE - select the "Taxonomy" node in the central panel and set at least these two 
mandatory entries: 

 Physical Taxonomy  

 Taxonomy  

For each of them click the "Browse" button and select the specific Physical and Logical 
Taxonomy, through dictionary files installed under <Extension Install 
Dir>\Dictionaries. 

 

In this essential description we do not consider Customised Taxonomies and other options. Refer 
to the "Repository Manager" help file for information. 

Options not used in this exemplary Repository configuration   

8. ATTACHMENTS CONFIGURATION NODE  
In the exemplary configuration described here there are no settings to perform. We store both the 
Occurrences and their Attachments in the same database, which is the default. If you need to use 
separate databases see page 98, Section "3.11.1 Separate Attachment database". 

9. E-MAIL STORAGE NODE 
In the exemplary configuration described here there are no settings to perform. 
ECCAIRS allows to send E-Mails through the Browser E-Mail Add-In, on either editing Attributes, 
selecting menu-items or upon a number of system events. The messages generated are then 
processed by the "Eccairs 5 E-Mail Service" which hands them over to an E-Mail Server for 
delivery. Also other ECCAIRS features, like User password recovery/reset (see next item), rely 
on the "Eccairs 5 E-Mail Service".  
Refer to the "ECCAIRS 5 E-Mail Add-In and Service White Paper" to configure and activate it. 

10. SECURITY POLICY NODE 
Password security policies are not used in this exemplary configuration. If you want to put 
prescriptions on Users' password composition, expiry, recovery/reset and lock out Users on too 
many failed login attempts, then refer to the "ECCAIRS 5 Password Management White Paper". 
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Create Profiles that qualifies different Roles or Role options 

11. PROFILES - now the Repository is formally valid but not yet usable, since you have no Users 
defined. But a User requires a Role, and a Role requires some Profiles to associate. 

Each Extension installs preset Profiles for most Profile categories in: 
<Extension Install Dir>\Profiles\<category>. 

 

Note that an Extension may not provide sample preset Profiles for every category. 

You can import the preset Profiles provided and, possibly, adapt them to your needs. 

 

A

B 

C

D
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To do this, select the Profile type node in the central panel, for instance "Security", and then 
select "Actions > Add Security Profile from file" menu-item and select the Profile in the 
<Extension Install Dir>\Profiles\<category> folder. 

For instance, in 32 bit systems, and for the AVIATION Extension you would find the predefined 
Security Profiles in: 
C:\Program Files\ECCAIRS5\Extensions\AVIATION\Profiles\Security 

Some Profiles-types are mandatory, i.e. you need at least one of those in order to define a valid 
Role. Roles require, for some Profile types, only a single Profile associated. For instance a Role 
allows only for a single Browser Profile and a single Security Profile.  
This means that if you need different Roles you have to define corresponding different Profiles of 
a Profile-type. 
Some type of Profiles may be multiple also within the same Role, to specify different options that 
the end User belonging to the Role can chose in a Client application (e.g. a View, a Report 
layout, etc). 

Mandatory Profiles 
To define a valid Role you must have to set at least: 

 Browser - each Role requires a single Browser Profile. 

 Security - each Role requires a single Security Profile. 

 View - each Role requires at least one View Profile, but it may have more than one, with one 
set as default. 

For more information refer to the "Repository Manager" documentation, where all the Profiles are 
described in detail. 
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Create Roles for different type of Users 

12. ROLES - select the "Roles" node in the central panel. Then select the "Action > Add Role" menu-
item.  

 

Then set: 

 Name - (mandatory) enter a name for the Role. Possibly also a description.  

 Available/Assigned Profiles - select from the "Available Profiles" panel the Profiles you 
want to add and click the "Add Profile" right-arrow-shaped icon-button. The mandatory Role 
Profiles, when not yet specified, are marked in red in the "Assigned Profiles" panel. 
You can create a Role without mandatory Profiles, but in this case the Role will be set to 
"Disabled". All Users belonging to that Role will not be able to log on the Repository. 

Whenever you make changes to a Role you need to confirm them before being able to work on 
another item. 

The other options may be left at their default status for the scope of this essential description. 
Refer to the "Repository Manager" help file, in which all the options are described in detail. 

Create Users and assign them a Role 

13. USERS - click on "Users" node in the central panel. Then select the "Action > Add User" menu-
item.  

B

A 

C

D
E
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Then set: 

 Name - (mandatory) enter a name for the User. Possibly also a description.  

 Password - enter a password for the User and confirm it. The password is case sensitive. 
Although it is not mandatory, but we strongly suggest to set it. 

 Assigned Role - select the Role for this User from the drop-down list. If you do not specify a 
Role the User will be set to "Disabled" and will not be able to log on the Repository. 

Whenever you make changes to a User you need to confirm them before being able to work on 
another item. 

The other options may be left at their default status for the scope of this essential description. 
Refer to the "Repository Manager" help file, in which all the options are described in detail. 

Validate and save the Repository 

14. Save the Repository 
Save the changes on the Repository to the Repository Server using the "Toolbar > Save changes 
to ..." icon-button. If not you will be prompted to save/discard changes when you switch to 
another Repository or try to close the "Repository Manager" application itself. 

15. Validate the Repository and debug it  
Check the Repository using the "Toolbar > Validate 'Repository-name'" icon-button. This function 
let you find and fix inconsistencies in a smooth way. Refer to the "Repository Manager" help file, 
where the use of this function is described. 

16. Verify the database structure 
From within the "Repository Manager" application you may also wish to check the structure of the 
Occurrence database associated to the Repository you are setting. 
Select the "Toolbar > Verify database structure" icon-button. 

B 

A 

C

D 
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17. Close the "Repository Manager" application. 

 

3.12.3. USING A REPOSITORY 

Once the Repository has been saved, it can be referred to during Client applications logon. 

To do this you have to define the connection to the Repository in the Server, using a supported 
communication protocol. 

For local Client applications, running on the same computer as the ECCAIRS 5 Server, there is no need 
to configure on the Server any access communication protocol. 

For all the options see Section "1.2 Installation options - Client", page 12 
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4. OPTIONAL SERVER COMPONENTS 

4.1. ADDITIONAL SERVICES AVAILABLE 
Beyond the basic installation and mandatory configurations, there are some optional Server components 
or services that you may wish to configure and use.  

Each Section in this Chapter contains installation and configuration instructions. 

 AUTOMATIC BACKUP 
See page 116, Section "4.2 Automatic Backup" for instructions. 

When the "Auto Backup" option is enabled in a Repository, all Occurrences changed or deleted 
are copied into a specific backup table in the Occurrence database. The "ECCAIRS Backup 
Service" periodically retrieves them from the backup table and move/copy them into a folder in 
the Server file system, from which they can be further handled (for example moved to optical disc 
or magnetic media). 
_____________________________________________________________________________  

 POSTPONED INDEXING 
See page 117, Section "4.3 Postponed Indexing" for instructions. 

When the "Indexing" option is set to "Postponed" in a Repository, the indexing of the narratives 
and the query tables is not performed immediately, as you enter or modify Occurrences. The 
"ECCAIRS Postponed Indexing Service" performs it at a programmed periodical interval. This 
option can be useful when importing or performing batch modifications on large number of 
Occurrences, for instance, to speed up the saving time. 
_____________________________________________________________________________  

 NUMBER GENERATOR ADD-IN 
See page 119, Section "4.4 Number Generator Add-In" for instructions. 

This is a Server component that, when invoked by the corresponding Add-in the ECCAIRS 
Windows/Web Browser, generates automatically “ECCAIRS Number” Attribute values, that is the 
Taxonomy/Organisation dependent identifier that uniquely identifies each Occurrence. 
_____________________________________________________________________________  

 E-MAIL MESSAGES SERVICE 
Refer to the "ECCAIRS 5 E-Mail Add-In and Service White Paper" to configure and activate it. 

ECCAIRS allows to send E-Mails directly from the Browser through the E-Mail Add-In, on either 
editing Attributes, selecting menu-items or upon a number of system events. The messages 
generated are then processed by the "Eccairs 5 E-Mail Service" which hands them over to an 
E-Mail Server for delivery. Also other ECCAIRS features, like User password recovery/reset, rely 
on the "Eccairs 5 E-Mail Service".  
_____________________________________________________________________________  

 PASSWORD E-MAIL ADVANCE EXPIRY NOTIFICATION SERVICE 
Refer to the "ECCAIRS 5 Password Management White Paper" to configure and activate it. 

ECCAIRS provides a number of User password security features and options. In particular, you 
can let the ECCAIRS Server notify Users by E-Mail, in advance, when their password will expire. 
This feature requires, beyond the "Eccairs 5 E-Mail Service", also the "Eccairs 5 Security 
Notification Service". 
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4.2. AUTOMATIC BACKUP 
When the "Auto Backup" option is enabled in a Repository, all Occurrences changed or deleted are 
copied into a specific backup table in the Occurrence database.  

 

The "ECCAIRS Backup Service" periodically retrieves the different versions of the changed Occurrences 
from the stored in the database backup table and move/copy them into a folder in the Server file system, 
from which they can be further handled (for example moved to optical disc or magnetic media). 

4.2.1. CONFIGURE THE "AUTOMATIC BACKUP" SERVICE 

The service needs to read the information stored in a configuration file named 
“E5ServiceBatchConfiguration.config”. 

This file is installed by the ECCAIRS 5 setup and it is by default placed in the following locations: 

 Windows Server 2003, Windows XP:  
C:\Documents and Settings\All Users\Application Data\ECCAIRS 5\Settings 

 Windows Server 2008, Windows Vista and Windows 7: 
C:\ProgramData\ECCAIRS 5\Settings 

Note that this file also contains configuration settings for the other batch services. 

To set the configuration parameters, open the “E5ServiceBatchConfiguration.config” 
configuration file, look for the <Backups> node and fill the following attributes values: 

1. RemoveBackup - if "True", removes the occurrence that is backed up from the backup table in 
the Database. Obviously the occurrence remains available in the normal occurrence database. 
Under normal circumstances this property could be set to "True" to avoid the backup table to 
grow. 

2. ForceBackup - if "True", the backup will be performed even if the specific occurrence was 
already backed up previously (and was not removed from the backup table). Under normal 
circumstances this property should be set to "False", to avoid that occurrences are repeatedly 
backed up. 

3. DirectoryBackup: the folder in which the backup files will be saved. Remember that if the 
directory your specify does not exist, you first have to create it. 
Also make sure that the "E5Administrator" user must have full permission on this directory. 
Note that the Automatic Backup service has no automatic subfolder generation, as was in 
Release 4.2. All Occurrences are stored in the same single destination folder. This function will 
be enhanced in a future release. 

4. LatencyTime - the time period (expressed in minutes) the service polls the database for 
Occurrences which have not been backed-up yet. 
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4.2.2. STARTING THE "AUTOMATIC BACKUP" SERVICE 

To start the "Automatic Backup ": 

1. Open the Windows "Services" window: "START > Administrative Tools > Services".  

2. Find and select in the Services list "ECCAIRS 5 Backup Service" and then "Right-click > 
Properties"  

3. In the "Log On" tab-panel set "Local System" as the “Log on user" for the service. 

4. In the "General" tab-panel start click on "Start" to run the "ECCAIRS 5 Backup" service. 

5. Set the "Startup type" to "Automatic", if you want to run the service all the times the Server 
computer starts up. If you wish to run tests or evaluate the "Automatic Backup" service, you can 
set the "Startup type" to "Manual". 

For the evaluation of the standard functionality of ECCAIRS 5 and the extension you can avoid using the 
"Automatic Backup" by not starting the service and by disabling the "Automatic Backup" in the 
"Repository Manager". 

 

 

4.3. POSTPONED INDEXING 
In the ECCAIRS Common Framework the indexing of the narratives and the query tables can be 
performed either immediately or postponed. 

The "Postponed Indexing" service is an application designed to generate the postponed indexes in 
background. 

Indexing can be enabled in the "Repository Manager" as one of the main properties of the Repository. 

 

When, using the" Repository Manager", the Repository indexing is set to "immediate" in the, both the 
narrative indexes and the query table indexes are created immediately when an Occurrence is inserted 
in the database. 

All users of the system will be seeing the indexed words from the narratives as well as the Occurrences 
when querying. This immediate response of the system comes at the costs of a somewhat slower 
storage of the Occurrence in the system. 

When the Repository indexing is set to "postponed" in the Repository Manager, the Occurrence is stored 
as fast as possible in the database and the creation of the indexes is postponed to a more suitable 
moment depending on a to be defined delay. 

The advantage of this mode of working is that the process of saving the Occurrence in the database is 
perceived by the user as going much faster. The disadvantage is that users might not find the recently 
inserted Occurrences when indexing is not yet completed. 

When postponed indexing is activated, the system will indicate to the interactive users, in the appropriate 
applications like for example the Query Builder, that a certain percentage of the database has not yet 
completed its indexing. 
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The "Postponed Indexing" service is an application designed to generate the postponed indexes in 
background. 

4.3.1. CONFIGURE THE "POSTPONED INDEXING" SERVICE 

The service needs to read the information stored in a configuration file named 
“E5ServiceBatchConfiguration.config”. 

This file is installed by the ECCAIRS 5 setup and it is by default placed in the following locations: 

 Windows Server 2003, Windows XP:  
C:\Documents and Settings\All Users\Application Data\ECCAIRS 5\Settings 

 Windows Server 2008, Windows Vista and Windows 7: 
C:\ProgramData\ECCAIRS 5\Settings 

Note that this file also contains configuration settings for the other batch services. 

To set the configuration parameters, open the “E5ServiceBatchConfiguration.config” 
configuration file, look for the <Postponeds> node and fill the following attributes values: 

 LatencyTime - the time period (expressed in minutes) the service polls the database for 
occurrences which have not been indexed yet. 

4.3.2. STARTING THE "POSTPONED INDEXING" SERVICE 

To start the "Indexing Service": 

1. Open the Windows "Services" window: "START > Administrative Tools > Services".  

2. Find and select in the Services list "ECCAIRS 5 Postponed Indexing Service" and then "Right-
click > Properties"  

3. In the "Log On" tab-panel set "Local System" as the “Log on user" for the service. 

4. In the "General" tab-panel start click on "Start" to run the "ECCAIRS 5 Postponed Indexing 
Service" service. 

5. Set the "Startup type" to "Automatic", if you want to run the service all the times the Server 
computer starts up. If you wish to run tests or evaluate the "Postponed Indexing" service, you can 
set the "Startup type" to "Manual". 

For the evaluation of the standard functionality of ECCAIRS 5 and the extension you can avoid using the 
postponed indexing by not starting the service and by disabling the "Postponed Indexing" in the 
"Repository Manager". 
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4.4. NUMBER GENERATOR ADD-IN 
This is a software Add-in to the ECCAIRS 5 Server that allows to generate automatically “ECCAIRS 
Number” Attribute values, that is the Taxonomy/Organisation dependent identifier the uniquely identify 
each Occurrence. 

The "Number Generator Add-In" is installed automatically with the ECCAIRS 5 Server software. 

However, to be used, it must be previously configured. 

The "Number Generator Add-In" can be configured both for Windows (in the "Browser Profile" of the 
Repository) and Web (in the "Web Profile" in the Repository). 

4.4.1. CONFIGURE THE "NUMBER GENERATOR" SERVICE 

In order to configure the "Number Generator" service, which will be then used by the "Number Generator 
Add-In", the creation of a "Tunnel Service" Profile is required. 

Perform the following steps: 

1. Run the "Repository Manager" application: "START > All Applications > Eccairs 5 > 
Administration > Repository Manager". 

2. In the "Repository Manager" application, select the Repository you are configuring and create a 
new "Tunnel Service" Profile. 

3. Provide a name for the profile in the "Identification" tab. 

4. Go to the "Tunnel Service" tab and click on the "Edit" button. 

5. An "Edit Tunnel service" dialog shows up. 
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6. Fill the fields as follows: 

 Name - enter a descriptive name for the configuration. 

 Activation Type - select ".net.NET activation"  

 Assembly/class pair - select the following Assembly/class from the corresponding drop-
down lists: 

o Number Generator Service 

o engsNumberGenerator". 

 Configuration - click on the "arrow button" on the right of the "Configuration" row. 
A "database connection" dialog shows up. 

 

7. In the "Database Connection" dialog you have to provide the connection and access parameters 
of the database with the report numbers table. 
In the current implementation of ECCAIRS 5 this is the same database where ECCAIRS 
Occurrence data is stored (see page 96, Section "3.11 Setup Occurrence databases"). 
You can get this data from what you wrote down at installation time in the "Server Installation 
Summary" form (printed from page 159 for stand-alone Server or page 163 for network-
accessible Server). 

Fill the fields as follows: 

 Description - enter a description. 

 Database type - select the database Type. 

 Username - the User that will be used to login into the database server. 

 Password - the corresponding User password. 

 Server name - the database Server name. 

 Database name - the database name. 

8. When database configuration is performed on the same computer acting as ECF Server, you 
may click on the "Test" button to verify that the database connection works.  

9. Click on "OK" to close the "Database Connection" dialog. 

10. Click on "OK" to close the "Edit Tunnel service" dialog  

11. Save the profile within the "Repository Manager" application. 
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4.4.2. CONFIGURE THE BROWSER AND WEB REPOSITORY PROFILES 

The procedure described in this paragraph is valid for both the Browser and Web Profile. 

In order to configure the Number Generator Add-In, the following procedure has to be performed: 

1. If not yet open, run the "Repository Manager" application: "START > All Applications > Eccairs 
5 > Administration > Repository Manager". 

2. Select the Repository you are configuring and open the "Browser Profile" (or "Web Profile") you 
want to configure. 

3. Go the "Add-Ins: Event Handlers" tab (the last tab). 

4. Click the first button on the right to add a new "Event Handler". 
The "Add/Edit new Event Handler" dialog shows up. 

 

5. In the "Add/Edit new Event Handler" dialog fill the fields as follows: 

 Name - enter a descriptive name for the configuration. 

 Activation Type - select ".net.NET activation"  

 Assembly/class pair - select the following Assembly/class from the corresponding drop-
down lists: 

o Number Generator Addin  

o engaNumberGenerator. 
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6. Click on the "arrow button" on the right of the "Configuration" row. 

7. The "Report Number Generator" dialog shows up. 

 

8. Fill the fields of the "Report Number Generator" dialog as follows: 

 Description - enter a description. 

 Service to connect to - select the (the "Number Generator Tunnel Profile" previously 
configured). 

 Report Pattern - enter the "Report Pattern". 
See page 123, Section "4.4.3 Report and Key Pattern" for details. 

 Key Pattern - enter the "Key Pattern".  
See page 123, Section "4.4.3 Report and Key Pattern" for details. 

 Test Pattern / Test Key - click on these buttons to test the patterns you entered. 

9. Click on "OK" confirm and exit the "Report Number Generator" dialog. 

10. Once back in the "Add new Event Handler" dialog do the following: 

1. Select the "Activating events". 
For the "Number Generator Add-In", the choice is "Before Occurrence Insertion". 

2. Click on "OK". 

3. Save the profile within the "Repository Manager" application. 
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4.4.3. REPORT AND KEY PATTERN 

Report Pattern 

This is the pattern that the "Number Generator Add-In" uses to create new unique and progressive 
identifier for an Occurrence report. 

It contains a numeric unique and progressive IDs returned into the [%$ID%] variable-placeholder tag, as 
in the "Report Pattern" shown in the sample "Report Number Generator" dialog shown above, and some 
other fixed or variable content.  
You can also specify to pad the ID number with a number leading 0 (zero) figures, up to a fixed total 
number of figures.  
For instance an ID number 176385, when 0-padded to 9 figures, would be returned as 000176385. 

The other parts of the pattern are made by fixed strings and tags.  

 Fixed strings in the "Report Pattern" may be composed by any set of characters except the [% 
%] tag identifier sequence. 

 Tags are identified by the [% %] delimiters and may include any reference to Attributes content 
associated with the Occurrence being reported, plus the current date, a special variable identified 
as the $DATE. 

Tags may include some formatting information. 
For instance, the [%$DATE(layout:3)%] tag specifies to return the year of the current date, e.g. 
2011 (during all year 2011).  
The [%$DATE(layout:4)%] tag layout would return the current day and the [%$DATE(layout:5)%] 
tag layout the current month. 

The "Report Pattern" shown inside the sample below would return, during year 2011, unique progressive 
identifiers of the type: 176385/2011. 

 

This value is returned to the ECCAIRS 5 Client application invoking the Add-In, typically the Browser 
when you enter new Occurrences. 

Key Pattern 

The Key Pattern is the domain where you wish that the Number Generator generates a new unique and 
progressive ID to fit in the "Report Pattern". 
When the value returned by the "Key Pattern" changes the progressive numbering will be reset. 

For instance, if the "Key Pattern" contains the current year, then the new IDs will be unique and 
progressive within the current year. This is what happens with the [%$DATE(layout:3)%] tag in the "Key 
Pattern" inside the sample "Report Number Generator" dialog shown above. 
The subsequent year the progressive numbering will be reset. 

The pattern is composed by fixed strings and tags, using the same syntax as specified for the Report 
Pattern. 

Pattern Syntax and Layout Options 

You can find the complete set of layout options in the "ECCAIRS 5 Custom Report Templates" White 
Paper, together with the syntax used to express Attribute values to be included in the pattern. 
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4.5. E-MAIL MESSAGES SUPPORT 
ECCAIRS allows to send E-Mails directly from the Browser through the E-Mail Add-In, on either editing 
Attributes, selecting menu-items or upon a number of system events.  

The messages generated are then processed by the "Eccairs 5 E-Mail Service" which hands them over 
to an E-Mail Server for delivery.  

Also other ECCAIRS features, like User password recovery/reset, rely on the "Eccairs 5 E-Mail Service".  

Refer to the "ECCAIRS 5 E-Mail Add-In and Service White Paper" to configure and activate the service. 

4.6. PASSWORD ADVANCE EXPIRY E-MAIL NOTIFICATION 
ECCAIRS provides a number of User password security features and options, for instance you can set a 
password expiry date. The options are set within the "Security Policy" Repository item. 

In particular, you can have the ECCAIRS Server notify Users by E-Mail, in advance, when their 
password will expire.  

This feature requires, beyond the "Eccairs 5 E-Mail Service", also the "Eccairs 5 Security Notification 
Service". 

Refer to the "ECCAIRS 5 Password Management White Paper" to configure and activate it. 

In that White Paper you also find all the password security options you can set in a Repository. 
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5. WEB SERVER INSTALLATION 

 

This chapter describes how to install the ECCAIRS 5 software on a Web Server.  

A Web Server Installation installs all the ECCAIRS 5 components such as the Server, the Client, the 
Web components and the Web site. 

 

Do the following: 

 Print the roadmap in Section 5.1. 
Read the Sections indicated in the roadmap and use the form as checklist for your installation 

 Print the "Web Server Installation Data Summary" forms, pages 167 to 171. 
Fill them up with the data and details of the specific installation you are performing. 

ECF  
WEB SERVER

OCCURRENCE AND 
ATTACHMENT DB 

ECCAIRS 5 WEB 
SERVER DB 

ECCAIRS 5 

REPOSITORY 1 

REPOSITORY 2 

REPOSITORY N 

REPOSITORY 
MANAGER 

ECCAIRS 5

BROWSER 

GRAPHER 

DATA 
MANAGER 

WEB USERS 
MANAGER 

ECCAIRS WEB 
ACCESS 

WEB SERVER 
INSTALLATION 

ECCAIRS 5 

REPOSITORY 1 

REPOSITORY 2 

REPOSITORY N 

REPOSITORY 
MANAGER 

OCCURRENCE AND 
ATTACHMENT DB 
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5.1. ROADMAPS AND CHECKLISTS 
There is a single roadmap encompassing all the ECCAIRS 5 Web Server installation options illustrated 
in Section "1.4 Installation ", page 22. 

 

Do you have an ECCAIRS 5 Server to connect to? 

The ECCAIRS 5 Web Server needs to communicate with a working and properly configured ECCAIRS 5 
Server, either local or on the network. 

ECCAIRS 5 Server installed on the same computer as the ECCAIRS 5 Web Server 

If you want to run and connect to a local ECCAIRS 5 Server, i.e. on the same computer where you have 
installed the ECCAIRS 5 Web Server, remember that also the ECCAIRS 5 Server software has been 
automatically installed on the same computer at ECCAIRS 5 Web Server installation time. 

In any case you still have to pickup the suitable roadmap for the Server access options you need and 
then perform the ECCAIRS 5 Server configuration steps in Section "3 SERVER INSTALLATION", page 
51, except the Server software installation step (Section "3.4 Install the Server software", page 60). 

If the local ECCAIRS 5 Server is used only by the ECCAIRS 5 Web Server, i.e. no other Client over the 
network will access the ECCAIRS 5 Server, then you may use the roadmap for the "Stand-alone Server". 
See page 52, Section "3.1.1 Stand-alone Server roadmap", again skipping the Server software 
installation step (Section "3.4 Install the Server software", page 60). 
In this configuration ECCAIRS will be accessible from other computers only via the Web interface. 
 

ECCAIRS 5 Server on another computer  

If you do not have a networked ECCAIRS 5 Server available yet and you want to install and run it on 
another computer, you first have to perform on that computer all the steps foreseen for a Server 
installation (Section "3 SERVER INSTALLATION", page 51). 
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5.1.1. WEB SERVER INSTALLATION ROADMAP 

Optional steps are marked in green. Print this page and use it as check-list. 

_____________________________________________________________________________  

 PRINT AND FILL THE INSTALLATION DATA SUMMARY FORMS 
Print the "Installation Data Summary" forms (pages 167 to 171) and write down the specific 
configuration parameters and the actual options installed. 

_____________________________________________________________________________  

 CHECK HARDWARE AND SOFWARE REQ. AND PRE-REQUISITES  
See page 129, Section "5.2 Requirements" for instructions and fill your printed installation forms. 

_____________________________________________________________________________  

 INSTALL WEB SERVER SOFTWARE 
See page 131, Section "5.3 Install the software". 

_____________________________________________________________________________  

 PERFORM CORE DCOM SETUPS  
See page 133, Section "5.4 Core Setups". 

_____________________________________________________________________________  

 CONFIGURE IIS  
See page 136, Section "5.5 Configure IIS". 

_____________________________________________________________________________  

 CREATE THE WEB SERVER OWN DATABASE 
See page 142, Section "5.6 Create the Web Server own database". 

_____________________________________________________________________________  

 SETUP AND CONFIGURE AN ECCAIRS 5 SERVER, IF YOU DO NOT ALREADY HAVE ONE 
Next step will also involve the connection to a Repository on an ECCAIRS 5 Server. 
If you do not have one installed, either locally or on the network, you must set it up. 
See page 51", Section "3 SERVER INSTALLATION". 

_____________________________________________________________________________  

 MANAGE THE ECCAIRS 5 WEB SERVER CONFIGURATION 
See page 145, Section "Web Configuration Manager". 

Here you also setup the different installation types seen in Section "1.4 Installation ", page 22: 

 REMOTE REPOSITORIES - DCOM ACCESS 

 REMOTE REPOSITORIES - WEB SERVICES ACCESS 

 LOCAL REPOSITORIES - LOCAL ACCESS TO ECCAIRS 5 SERVER 

_____________________________________________________________________________  

 OPTIONALLY CONFIGURE WINDOWS AUTHENTICATION FOR WEB ACCESS 
See page 149, Section "6.1 Windows Authentication for Web" 

_____________________________________________________________________________  
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CHECK 
REQUIREMENTS 

INSTALL THE 
SOFTWARE 

CORE SETUPS 
(DCOM) 

PERFORM 
ECCAIRS WEB CONFIGURATION 

SETUP WEB SERVER SESSION DATABASE 

MS SQL SERVER ORACLE 

CONFIGURE IIS 

IIS 6 IIS 7 

USABLE  
ECCAIRS 5 WEB SERVER  

CONFIGURE  
WINDOWS AUTHENTICATION 

FOR THE WEB 
OPTION 

SETUP AND CONFIGURE AN 
ECCAIRS 5 SERVER 

IF YOU DO NOT HAVE ONE  
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5.2. REQUIREMENTS 

Remember to fill the "Web Server Installation Data Summary" forms you printed (from pages 167 to 171) 
with the specific Hardware, Software and Pre-requisites of the installation you are performing. 

Hardware Requirements - ECCAIRS 5 Web Server 

Optional requirements, suitable only to specific installation choices or options, are marked with a pale 
green background. 

 HARDWARE REQUIREMENTS 

  CPU: DUAL CORE OR BETTER  

 
 RAM: 4 GB (min 2GB + 50 MB per concurrent 

User connection) 

 

 
 HD: 300 MB FREE SPACE  

(for the ECCAIRS 5 Server, the IIS Web 
Server) 

 

O
P

T
IO

N
 

 HD ADDITIONAL SPACE FOR 
OCCURRENCE DATBASE, if the ECCAIRS 5 
Server also hosts the Occurrence and/or 
Attachments database. 

 300 kB per Occurrence 

 Suitable Attachments space 

 

O
P

T
IO

N
 

 HD ADDITIONAL SPACE FOR WEB USERS 
DATABASE, if the ECCAIRS 5 Web Server 
computer also hosts the database used for the 
Web Server itself to store the Web submitted 
User Queries. 

 Minimum 100 MB 

 Then space proportional to the number of 
concurrent users: 

o Suppose 50 Queries per Web User 

o 50 kB per Query 

o 50 MB for logging 
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Software Requirements - ECCAIRS 5 Web Server 

Optional requirements, suitable only to specific installation choices or options, are marked with a pale 
green background. 

 SOFTWARE REQUIREMENTS 

 

 OS: 

 Windows 7 (32/64 bit) 

 Vista (32/64 bit) 

 Windows XP SP3 (32/64 bit) 

 Windows Server 2008 R2 (32/64 bit) 

 Windows Server 2003 (32/64 bit) 

 

  IIS 6 or IIS 7 INSTALLED  

  .NET 4.0 FULL INSTALLED  

O
P

T
IO

N
  ORACLE DATABASE CLIENT SOFTWARE 

only when the ECCAIRS 5 Web database is 
hosted in an Oracle RDBMS: 

 32 bit Oracle client with ODAC components 
installed 

 

 

Other Pre-Requisites - ECCAIRS 5 Web Server 

Optional requirements, suitable only to specific installation choices or options, are marked with a pale 
green background. 

 OTHER PRE-REQUISITES 

 

 

 ECCAIRS 5 SERVER INSTALLED AND 
CONFIGURED, either local on the same 
computer or remote on a network-accessible 
computer. 

 If the ECCAIRS 5 Server is installed on the 
same computer then you must also check all 
the requirements for a Standalone ECCAIRS 5 
Server  
See page 56, Section "3.2 Requirements 
(Stand-alone Server) ". 

 

 

 WEB RDBMS (DATABASE Server) 
INSTALLED either local on the same computer 
or remote on a network-accessible computer. 

 Microsoft SQL Server 2005 or higher (both 
express and enterprise versions) 

 Oracle (version 10.2 or higher) 
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5.3. INSTALL THE SOFTWARE 

The ECCAIRS 5 distributable setup software is a single executable file that you normally download via 
Internet, or read from a DVD-ROM. 

To install the ECCAIRS 5 Server proceed as follows: 

4. Execute the distributable setup file to extract the setup files. 
You have to specify a folder where the setup files will be put. 

5. Open the folder where the files have been extracted and execute the set-up program called 
"E5ECFSetupV5nnn.exe", where nnn are 3 digits that qualify the specific release you are 
installing. 

6. Accept the license agreement and click on "Next" to continue. 

7. In the subsequent “Destination Folder” dialog: 

 Specify the installation folder for your application. 
If possible, keep the default installation folder proposed:  
C:\Program Files\ECCAIRS5 (in 32 bit systems) 
C:\Program Files (x86)\ECCAIRS5 (in 64 bit systems). 
If you decide to change the installation folder, write down its full path in the "Server 
Installation Summary" form (page 169).  
References to this folder will be made further on within this Manual. 

 Select whether the ECCAIRS Client applications will be available in the START menu only for 
the Windows user who is currently installing the software (“Just me”) or for all users 
(“Everyone”, default choice). 

 Click on "Next" to continue. 

8. Select "Web Server" in the "Setup Type" dialog and click on "Next" to continue. 
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9. In the subsequent "Web Site Folder" dialog you can specify the folder where to install the 
ECCAIRS 5 Web Site components. 

 The ECCAIRS 5 Web site root folder, where all the files are extracted is by default: 
C:\E5WebSite. 

 If you extract the Web Site in another folder, write the full path of the root folder in the "Server 
Installation Summary" form (printed from the template on page 169). 

 

10. Click on "Next". 

11. In the "Ready to install the Program" dialog click on "Install". 
The software installation will start. 

12. When the installation is over a click on the "Finish" button to exit. 

13. On exiting, the ECCAIRS 5 setup the "Test ECCAIRS 5 Installation" tool is automatically started 
and shows the result of an automatic check of all the software components installed. 
All the items in the "Summary" tab should be ticked and marked in green. 
If any item is not marked in green contact the JRC ECCAIRS Coordination and Development for 
support and/or refer to the "Test ECCAIRS 5 Installation" tool own help and documentation.  
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5.4. CORE SETUPS 

In this Section we describe the configuration of the Web Server related parameters. 

5.4.1. CREATE AND CONFIGURE THE E5WEBADMINISTRATOR USER 

Create and configure a E5WebAdministrator user as follows: 

1. CREATE THE ECCAIRSWEBUSERS GROUP 

 Right-click on the "Computer" icon on the Desktop and select "Manage". 

 From the "Server Manager" Root node select the "Configuration" node. 

 Select the "Local Users and Group" node. 

 Select the "Groups" node, then right-click in the main pane and choose "New Group". 

 Create an “EccairsWebUsers” group and exit. 

2. CREATE THE E5WEBADMINISTRATOR LOCAL USER  

 Right-click on the "Computer" icon on the Desktop and select "Manage". 

 From the "Server Manager" Root node select the "Configuration" node. 

 Select the "Local Users and Group" node. 

 Select the "Users" node, then right-click in the main pane and choose "New User". 

 Enter "E5WebAdministrator" as new user name. 

3. SET THE E5WEBADMINISTRATOR USER PROPERTIES  

 Deselect the "User must change password…". 

 Select the "User cannot change password". 

 Select the "Password never expires". 

 Assign a suitable password and store it in a safe place. 
Write down the password in the specific "Server Installation Summary" form of the installation 
you are performing (printed from the template on page 169, Section "Summary of Options 
Installed - ECCAIRS 5 Web Server"). 

  Click on the "Create" button, and then close the window. 

4. ASSIGN GROUP MEMBERSHIP  

 Now the "Users" main pane will contain the "E5WebAdministrator" user. 

 Right-click on it and select "Properties". 

 Click on the "Member Of" tab and assign "E5WebAdministrator" to the groups: 

o EccairsWebUsers. 

o PowerUsers. 

o Distributed COM Users (only in Windows Server 2003, Server 2008 and Windows 7). 

o IIS_WPG (only in Windows Server 2003) 

o IIS_IUSRS (only in Windows 7 and Windows Server 2008). 
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 Apply the changes and exit. 

5. ASSIGN USER RIGHTS 

 For Windows Server 2003: 

o Click on "Administrative Tools - Local Security Policy". The "Local Security Settings" 
window opens. 

o Select "User Rights Assignment". 

o Assign the "Log on as a Batch Job" user rights to "E5WebAdministrator": 

 For Windows Server 2008: 

o Go to "Local Security Policy".  

o Select "Local Policies". 

o Select "User Rights Assignment". 

o Assign the "Log on as a Batch Job" user rights to "E5WebAdministrator". 

5.4.2. WEB SESSION COMPONENT DCOM CONFIGURATION 

To configure the ECCAIRS 5 Web Session component, perform the following steps: 

1. Select "START > Run" and type: 

 dcomcnfg (for 32 bit systems). 

 comexp.msc -32 (for 64 bit systems). 

2. The "Component Services" dialog opens. 

3. From the root node select "Component Services > My Computer > DCOM Config" node. 

4. Select the ECCAIRS 5 Web Session icon (it should be the first or second item in the list). 

5. Select "Right-click > Properties" menu-item. 
A "Property" dialog with multiple tabs shows up. 

6. In the "General" tab select "Connect" as "Authentication Level". 

7. In the "Location" tab make sure that the "Run application on this computer" option is selected. 

8. In the "Security" tab perform the following operations: 

 In the "Launch and Activation Permissions" panel click on the "Customize" button and 
then on the "Edit" button. 

 Add the "EccairsWebUsers" group and grant the "Local Launch" and "Local Activation" 
permissions. 

 In the "Access Permissions" panel Click on the "Customize" button and then "Edit" button. 

 Add the "EccairsWebUsers" group and grant the "Local Access" permission. 

 Leave the options for "Configuration Permissions" as they are. 

 Apply and exit 

9. In the "Identity" tab make sure that the "This User" option is selected and choose the 
"E5WebAdministrator" user. 
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5.4.3. PERMISSIONS ON WEB SITE FOLDER 

The setup process creates a work sub-folder within the ECCAIRS 5 Web site root folder: 

C:\E5WebSite\Temp 

In case if you extracted the Web Site in a folder, another than "C:\E5WebSite ", the "Temp" sub-folder 
has been created there. You may have noted the full path of the Web Site root folder in the in the 
"Server Installation Summary" form (printed from the template on page 169). 

Set the write permission of that sub-folder to "Everyone". 
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5.5. CONFIGURE IIS 
You now have to configure IIS. 

The configuration steps are different for the two versions of IIS supported Proceed with either: 

 Section "5.5.1 IIS 6 Configuration", page 136 
(Windows XP, Windows 2003 Server). 

 Section "5.5.2 IIS 7 Configuration", page 139 
(Windows Vista, Windows 7, Windows 2008 Server). 

5.5.1. IIS 6 CONFIGURATION 

This section deals with the setup of IIS 6, which is the version of IIS which comes with Windows XP and 
Windows 2003 Server. Skip to Section "5.5.2 IIS 7 Configuration", page 139 for IIS 7. 

Before configuring make sure that IIS is installed/turned on, on the system. 

Additional setup for IIS 6 running on a 64-bit system 

If you are using IIS 6 on a 64-bit system, before proceeding you have to configure it to run 32-bit 
applications performing the following actions: 

1. Open a command prompt. 

2. Navigate to the %systemdrive%\Inetpub\AdminScripts directory. 

3. Type the following command: 
cscript.exe adsutil.vbs set W3SVC/AppPools/Enable32BitAppOnWin64 “true”  

4. Press the ENTER key. 

Configure the ECCAIRS 5 Web Site 

Perform the following steps: 

1. Select "START > Administrative Tools > Internet Information Services (IIS) manager". 

2. Select the "Application Pools" group and then the "Right-click > New > Application Pool" 
menu-item. 

3. Name "Eccairs Pool" the new Application Pool. 

4. Select the "Eccairs Pool" icon and then "Right-click > Properties" menu-item. 

 In the "Identity" tab select the "Configurable" option. 

  Set the "E5WebAdministrator" user as the user. 

 Apply the changes. 

5. Select the "Default Web Site" icon in the "Web Sites" group, then select "Right-click > New > 
Virtual Directory". 

 Enter a suitable name (e.g. MyECCAIRSWebSite). 
Write it down in the "Server Installation Summary" form (printed from the template on page 
169). 

 Click on "Next". 
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 Set the path for the virtual directory (by default it is C:\E5WebSite). 
If you have chosen another Web site root folder, you can read back its full path that you have 
written in the "Server Installation Summary" form (printed from the template on page 169) 
when installing the ECCAIRS 5 Web Server. 

 Click on "Next". 

 Assign the "Read and Run Scripts" (such as ASP) permissions. 

 Click on "Next" to complete the creation of the virtual directory. 

6. Select the virtual directory you have just created and then "Right-Click > Properties" menu-
item. The "Properties" dialog shows up. 

 In the "Virtual Directory" tab of the "Properties" dialog assign the "Eccairs Pool" to the 
virtual directory. 

 In the "Directory Security" tab, click on the "Edit" button of the "Authentication and 
Access control" section. 

 Check the "Enable Anonymous Access" option and set "E5WebAdministrator" as user. 

 As an alternative to basic authentication (Anonymous) described above, it is possible to make 
use of Windows Authentication. See Section "Windows Authentication for Web ", page 149. 

 On the "Documents" tab remove all the files except a file named “default.asp”. 

7. Click on the "Web Service Extensions", and set the "Active Server Pages" status to "Allowed". 

8. Select the "Local Computer" node on IIS Manager, select "Properties" and check "Enable 
Direct Metabase Edit" option. 

9. Close the "Internet Information Services (IIS) manager". 

10. Browse to <Windows Folder>\System32\Inetsrv 

11. Open the MetaBase.xml file with a suitable editor (e.g. notepad will do) and: 

 Search for the "AspBufferingLimit" parameter and set its value to “36777216” 

 Search for the "AspMaxRequestEntityAllowed" parameter and set its value to 
“1073741824” 

Enable HTTP Compression 

Perform the following steps: 

1. Select "START > Administrative Tools > Internet Information Services (IIS) manager". 

2. Select the "Web Sites" group and then the "Right-click > Properties” menu-item. 

 

3. Select the “Service” tab and set the HTTP Compression options: 

 "Compress Application files". 
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 "Compress Static files". 

 "Maximum temporary directory size" to “unlimited”. 

. 

4. Restart IIS. 

Skip next Section 

Skip the next Section since it deals with the other release of IIS, IIS 7. 
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5.5.2. IIS 7 CONFIGURATION 

This section deals with the setup of IIS 7, which is the version of IIS which comes with Windows Vista, 
Windows 7 and Windows 2008 Server. If you have IIS 6 refer to Section "5.5.1 IIS 6 Configuration", page 
136 ". 

The following Server Role must be enabled:  

 Web Server (IIS) 

The following Role Services must be enabled:  

 Common HTTP features: 

 Default Document 

 Application Development features: 

 ASP.Net  

 ASP 

 Security features: 

 Basic Authentication 

 Windows Authentication 

 Performance features: 

 Static Content Compression 

 Dynamic Content Compression 

 

Perform the following steps: 

5. Select "START > Administrative Tools > Internet Information Services (IIS) manager". 

6. Select the "Application Pools" node in the left panel of the IIS Manager under your local 
computer name and then the "Right-click > Add Application Pool…" menu-item. 

7. An "Edit Application Pool" dialog shows up. 

 

Perform the following steps: 

 Name - enter "Eccairs Pool" as the new pool name. 
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 NET Framework version: - select ".NET Framework v4.n.nnn" from the drop-down list, 
where the n.nnnnn digits identify the specific subversion of the .NET Framework 4 installed 
on your computer. 

 Managed Pipeline Mode - from the drop-down list select  

o "Integrated" (if you have SP1 installed on Windows 7/Windows 2008 server R2)  

o "Classic" (if you do not have SP1 installed) 

 Start application pool immediately - select this check-box. 

 Click on "OK" to confirm and close the "Edit Application Pool" dialog. 

8. Select "Eccairs Pool" in the central panel of the IIS Manager and then "Right-click > Advanced 
Settings". 

9. The "Advanced Settings" dialog shows up. 
Perform the following steps: 

 (only for 64 bit Operating Systems) 
In the "(General)" section set “Enable 32-Bit Applications” as "True". 

 In the "(Process Model)" section set the "Identify" by clicking on the "..." button on its right. 

 An "Application Pool Identity" dialog shows up. 

 Select "Built-in account" radio-button. 

 Select "LocalSystem" from the drop-down list. 

 Click on "OK" to confirm and close the "Application Pool Identity" dialog and you get back 
to the "Advanced Settings" dialog. 

 Click on "OK" to confirm and close the "Advanced Settings" dialog. 

10. Select the "local computer name > Sites > Default Web Site" node and then the "Right-click > 
Add Application" menu-item. The "Add Application" dialog shows up. 

 

11. Choose an "Alias" for your Application, for instance "E5Web". 
Write it down in the "Server Installation Summary" form (printed from the template on page 169). 

12. Assign the "Eccairs Pool" as the "Application Pool". 

13. Select as "Physical path" the ECCAIRS Web site root folder (by default it is C:\E5WebSite). 
If you have chosen another Web site root folder, you can read back its full path that you have 
written in the "Server Installation Summary" form (printed from the template on page 169) when 
installing the ECCAIRS 5 Web Server. 

14. Click on the "Connect As…" button, and in the "Connect As" dialog that opens, select "Specific 
User". 
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15. In the "Set Credentials" dialogs provide the "E5WebAdministrator" credentials and click on "OK" 
to confirm and close both the "Set Credentials" and "Connect As" dialogs. 

 

16. Before confirming and closing the "Add Application" dialog with the "OK" button, we suggest to 
use the "Test Settings…" button check the configuration. 

17. Once back in the "Internet Information Services (IIS) manager" main window, double-click the 
"ASP" icon to show the ASP-related properties. 
Expand the "Limit Properties" and set the following parameters: 

o Maximum Requesting Entity Body Limit - 1073741824 

o Response Buffering Limit - 36777216 

18. Be sure to confirm/apply all the changes made and restart IIS. 

As an alternative to basic authentication (Anonymous) described above, it is possible to make use of 
Windows Authentication. See page 149, Section "Windows Authentication for Web ". 
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5.6. CREATE THE WEB SERVER OWN DATABASE 

The Web Application uses a database to maintain the administrative data of the web site. 

Two types of RDBMS are supported, and separate configuration instructions are given: 

 Oracle 10.2 or higher (Section "5.6.1 Web database configuration (Oracle)", page 142) 

 Microsoft SQL Server 2005 and 2008 (Section "5.6.2 Web database configuration (SQL Server)", 
page 144). 

5.6.1. WEB DATABASE CONFIGURATION (ORACLE) 

In order to use ECCAIRS 5 with an Oracle Database, the following components are required to be 
installed: 

 Oracle Client 10.2 (or higher) including the following modules: 

 Oracle Windows Interfaces. 

 Oracle Provider for OLE DB. 

 Oracle Net. 

5.6.1.1. TABLESPACES AND VOLUMES 

The database you create must be Case-Insensitive. 

The following tablespaces and volumes are required. 

Tablespace Tablespace Name 
Initial 
size 

Additional space required per 
time slice 

Data  ECCAIRS5_WEBDAS 100 MB ~ 1MB/month 

Blob  ECCAIRS5_WEBDAS_BLOB 200 MB ~ 20MB/month 

User default ECCAIRS5_DEFAULT 300 MB fixed 

 

5.6.1.2. CREATING THE SCHEMA OWNER 

To create the Schema Owner, create a user with the following settings: 

Schema owner: <SCHEMA_OWNER> 

Password: to be defined 

Default tablespace: ECCAIRS5_DEFAULT 

Temporary tablespace System default or any other temporary tablespace 

Role grants: Connect, Resource 
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System Privileges: Create view, create procedure, create sequence, 
create session, create table, create trigger, create 
type  

Quotas unlimited quotas on ECCAIRS5_DEFAULT 

unlimited quotas on ECCAIRS5_ WEBDAS 

unlimited quotas on ECCAIRS5_WEBDAS_BLOB 

 

5.6.1.3. CREATE THE DATABASE SCHEMA 

1. Use the appropriate database management tools provided by Oracle and connect as 
<Schema_Owner> user. 

2. Execute the "CreateE5WebDASSchema ORACLE.sql" script  

You find the script in folder: "<Install Dir>\Web Database Scripts". 

The <Install Dir> is the ECCAIRS 5 Web Server install folder path that you wrote down in the 
specific "Server Installation Summary" form of the installation you are performing (printed from the 
template on page 169, Section "Summary of Options Installed - ECCAIRS 5 Web Server"). 
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5.6.2. WEB DATABASE CONFIGURATION (SQL SERVER) 

This Section contains specific instructions for setting up an ECCAIRS database running on Microsoft 
SQL Server 2005 and SQL Server 2008. 

We assume that either release of SQL Server has been installed prior to following the instructions. 

5.6.2.1. CREATE AND CONFIGURE WEB DATABASE  

A MS SQL Server database needs to be created and configured before ECCAIRS 5 Web Server can use 
it to manage Web Users operations. 

1. Connect to a SQL Server instance with a user with sufficient privileges to create a Database. 
Make sure that the SQL Server instance supports SqlServer authentication. 

2. Create a new database. This brings up the dialog where you can set all properties for the new 
database and its transaction log. The database you create must be Case-Insensitive. 

3. Create a new database User for the database just created and set the authentication to "SQL 
Server authentication".  
Assign to this user the “dbowner” privilege on the ECCAIRS 5 Web database. 

4. Execute the "CreateE5WebDASSchema SQL Server 2005-2008.sql" script. 
You find the script in folder: "<Install Dir>\Web Database Scripts". 
The <Install Dir> is the ECCAIRS 5 Web Server install folder path that you wrote down in 
the specific "Server Installation Summary" form of the installation you are performing (printed 
from the template on page 169, Section "Summary of Options Installed - ECCAIRS 5 Web 
Server"). 

5. Write down database name, user and access data in the specific "Server Installation Summary" 
form of the installation you are performing (printed from the template on page 169, Section 
"Summary of Options Installed - ECCAIRS 5 Web Server"). 
If you are installing the database on a different computer from the one where you have installed 
the ECCAIRS 5 Web Server, note down also the database computer name. 
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5.7. WEB CONFIGURATION MANAGER 
The ECCAIRS 5 Web Server needs to communicate with a working and properly configured ECCAIRS 5 
Server, either local or on the network. 

Therefore remember that, if you do not have such ECCAIRS 5 Server available yet, you first have to 
perform all the steps foreseen for a Server installation (Section "3 SERVER INSTALLATION", page 51). 

If you want to run and connect to a local ECCAIRS 5 Server, on the same computer where you have 
installed the ECCAIRS 5 Web Server, then you have to perform all the steps in Section "3 SERVER 
INSTALLATION", page 51, except the Server software installation (Section "3.4 Install the Server 
software", page 60), because the Server software is automatically installed when selecting a Web Server 
installation type. 

 

To run the ECCAIRS 5 Web Server you need to configure it for your specific use through the Web 
Configuration Manager: 

1. Select "START > All Applications > Eccairs 5 > Administration > Web Configuration 
Manager". 

2. In its left panel select the Virtual Directory you created for the Web site, then select "Right-click 
> Create configuration" menu-item. The "ECCAIRS 5 Web Configuration Manager" dialog 
shows up. 

3. The "name" displayed in the dialog is the name of the Web site that you defined for the ECCAIRS 
5 Web Server site. You can however provide a "Description" for this configuration in addition to 
the configuration data. 

 

In the right panel you find some parameters and settings. A few may be left at their default values, if 
suitable for your installation.  
Other parameters have no default value and must be filled as follows: 

 Maximum allowed users - the number of Users after which access to the web-site will be 
refused and a message will be displayed to the User telling to retry later since the web site is too 
busy. 

 Server applications limit - the maximum number of worker processes that can be spawn on the 
server by the web site. 
Consider that each worker process allocates ~140 MB in memory, plus ~8 MB per connected 
User. 
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 Sessions per application limit - the maximum number of ECCAIRS sessions that are allowed 
per each worker process. 
Consider that a maximum of 10 ECCAIRS sessions can share the same connection to a 
Repository Server, which requires additional ~140 MB (at most) in memory. 

 Server type  
This dropdown list allows to specify the web site behaviour: 

o Dedicated server (default) - this means that as Users connect to the web site the number 
of worker processes increases until it reaches its limit, then a single process is reused 
and shares more than an ECCAIRS session (if allowed). 
This approach requires more memory on the server since a greater number of worker 
processes is created but it produces better performances when the number of Users is 
low. 

o Shared server - this means that a single worker process is created when the first User 
connects and it is reused until it reaches the maximum number of ECCAIRS sessions, 
then a new worker process is created. 
This approach requires less memory but may slow down the responses to the Users even 
when few of them are connected. 

 Database connection (mandatory)  
Here you configure the connection to the database created in Section "5.6 Create the Web 
Server own database", page 142. Clicking on the "database" icon on the right of the field a 
"Database connection" dialog opens. 

 

You can recall the data to fill in the "Database connection" dialog from what you wrote down in 
the specific "Server Installation Summary" form of the installation you are performing (printed 
from the template on page 169, Section "Summary of Options Installed - ECCAIRS 5 Web 
Server"). 

 User profiles path (mandatory) 
Here you specify the User Profiles folder path created during the installation. 
The User Profiles folder depends on the operating system where the ECCAIRS 5 Server is being 
installed: 

o Windows Server 2003, Windows XP: 
C:\Documents and Settings\All Users\Application Data\ECCAIRS 5\UserProfiles 

o Windows Server 2008, Windows Vista, Windows 7: 
C:\ProgramData\ECCAIRS 5\UserProfiles 

If you browse the computer folders to browse and select the suitable User Profiles folders, you 
first need to enable the visualisation "hidden files and folders", since the Profile folders are 
hidden. 
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This means that, before browsing, you must: 

 Click on "Computer" on your Windows desktop. 

 In the folder/file Explore windows that opens, select the "Tools > Folder Options" menu-
item. 

 In the "Folder Options" dialog select the "View" tab-panel. 

 Select the "Show hidden files, folders and drives" option. 

 Click on "OK". 

 Edit Repositories (mandatory) 
The ECCAIRS 5 Web Server requires to connect to one or more Repositories on ECCAIRS 5 
Servers either on the same computer or networked. 
The Repository you link to must have a "Web Profile" defined. 
See Section "3.12 Setup Repositories", page 104, and refer to the "Repository Manager" 
application own documentation for details. 
 
Proceed as follows: 

 Click on the "Edit Repositories" link to enable the Repository (or Repositories) you have 
created. 

 A login form will appear. 

 Click on "More", "Add" and then "Browse". 

 The methods to find Repositories are the same as explained for an ECCAIRS 5 Client in 
Section "2.4 Connect to an ECCAIRS Server", page 35. 

 Once the server has been discovered, click on "List."  
A list of the available repositories will be shown. 

 Select the Repository you want to be available through the ECCAIRS Web site. 

 Perform a login with a User you have previously created for that Repository. 

Repeat this step for each Repository you want to be available in the ECCAIRS Web site. 

Once you have made/modified all the settings be sure to save and publish them, using the Toolbar 
buttons on the top of the "ECCAIRS 5 Web Configuration Manager" dialog. 

Be careful to perform these step if you do not want to loose your configuration. 
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6. OPTIONAL WEB SERVER COMPONENTS 

Beyond the basic installation and mandatory configurations, there are some optional Web Server 
features or components that you may wish to install. 

There is currently only one optional feature you may setup: 

 WINDOWS AUTHENTICATION FOR WEB ACCESS 
See page 149, Section "6.1 Windows Authentication for Web" for instructions. 
Using Windows Authentication let you use your Windows credentials to access the ECCAIRS 5 
Web, bypassing ECCAIRS own User authentication.  
This may be useful when using the ECCAIRS 5 Web Server over the LAN and administering the 
access permission through Active Directory service, for instance. 

 

 

6.1. WINDOWS AUTHENTICATION FOR WEB  
Windows authentication allows the users to connect to an ECCAIRS Repository using their Windows 
credentials in place of their ECCAIRS credentials.  
To allow Users to connect using this technique it is sufficient to add the Users in the Repository Manager 
by creating them as usual, selecting ‘Windows user’ or ‘Windows user group’ in the ‘User type’ dropdown 
and specifying an additional information, the ‘Domain’ of the User or Group.  
If a group has been specified all Users belonging to that Group are granted access permissions with the 
configured Role in the ECCAIRS system. 

Windows Authentication in the Windows environment 

Windows authentication is enabled by default within the Windows environment and cannot be disabled.  
Using any ECCAIRS 5 Client application (e.g. Browser, Data manager, etc) the User can access the 
system by selecting ‘Windows" in the "Authentication" drop-down list in the Login window. 
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Windows Authentication in the Web environment 

To enable Windows Authentication in the Web environment it is necessary to modify the web application 
/ virtual directory configuration. 

The procedure is slightly different for the two current versions of IIS: 

 IIS6 - see page 151, Section "6.1.1 IIS 6 - Setup for Windows Authentication" 
(Windows XP, Windows 2003 Server). 

 IIS7 - see page 151, Section "6.1.2 IIS 7 - Setup for Windows Authentication" 
(Windows Vista, Windows 7, Windows 2008 Server). 

Before proceeding make sure that the ECCAIRS 5 Web Server is installed and configured as described 
in Section "5 WEB SERVER INSTALLATION", (see page 125). 

Mozilla Firefox 3 Browser Setup Needed 

In Mozilla Firefox 3, Windows Authentication is disabled by default. 

To enable it to access an ECCAIRS 5 Web Server with Windows Authentication enabled, navigate to 
"about:config" (i.e. enter the address "about:config" in the address bar) and then locate the two 
preference items: 

 network.negotiate-auth.delegation-uris 

 network.negotiate-auth.trusted-uris 

Select one of them and use the "Right-click > Modify" menu-item to enter the complete name of the 
ECCAIRS 5 Web Server (i.e. its URI). For instance "server.myorg.com".  
If you need to add several Servers, enter each Server name separated by a comma (,"). 

Repeat the same procedure for the other preference item. 
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6.1.1. IIS 6 - SETUP FOR WINDOWS AUTHENTICATION 

This section deals with the setup of IIS 6, which is the version of IIS which comes with Windows XP and 
Windows 2003 Server.  
For IIS 7 skip to Section "6.1.2 IIS 7 - Setup for Windows Authentication" (see page 151). 

Do the following: 

1. Select "START > Administrative Tools > Internet Information Services (IIS) manager". 

2. Select the virtual directory of the ECCAIRS 5 Web Server and then "Right-Click > Properties" 
menu-item. The "Properties" dialog shows up. 

 In the "Directory Security" tab of the "Properties" dialog, locate the "Authentication and 
Access control" section and click on the "Edit" button. 

 Uncheck the "Enable anonymous access" option. 

 Check the "Integrated Windows authentication" option. 

6.1.2. IIS 7 - SETUP FOR WINDOWS AUTHENTICATION 

Do the following: 

1. Select "START > Administrative Tools > Internet Information Services (IIS) manager". 

2. Select your "local computer name > Sites > ECCAIRS 5 Web Server name" node in the left 
panel of the IIS Manager. 

3. In the right pane select the "Authentication" icon and double-click it or press the Enter key.  
By default the all the authentication types should be disabled except for "Anonymous 
authentication". 

4. Select "Anonymous authentication" and then the "Right-click > Disable" menu-item. 

5. Select " Windows authentication" and then the "Right-click > Enable" menu-item. 
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7. FORMS TO PRINT AND FILL 

7.1. HOW TO USE THESE FORMS 
Print any of the following forms which suits the ECCAIRS installations you are making and fill them up 
with the actual settings you make. 

For each type of installation you find a checklist of the hardware and software requirements, with space 
for annotations on your specific case. 

The third form collects a configuration data summary. All the installation options are listed: you should 
mark the check-boxes of the options chosen for your specific installation and specify the corresponding 
configuration data used. 

This data may be useful both to document the installations made and as information to provide for 
system support. 

 

 

The printable forms available are: 

7.2. Client Inst. Data Summary ......................................................................................................155 
Hardware Requirements – ECCAIRS 5 Client........................................................................155 
Other Pre-Requisites - ECCAIRS 5 Client ..............................................................................155 
Software Requirements – ECCAIRS 5 Client .........................................................................155 
Repository Connection Settings – ECCAIRS 5 Client ............................................................156 

7.3. Stand-alone Server Inst. Data Summary ................................................................................157 
Hardware Requirements - ECCAIRS 5 Server (Stand-alone) ................................................157 
Other Pre-Requisites - ECCAIRS 5 Server (Stand-alone)...................................................... 157 
Software Requirements - ECCAIRS 5 Server (Stand-alone)..................................................158 
Summary of Options Installed - ECCAIRS 5 Server (Stand-alone) ........................................ 159 

7.4. Network-accessible Server Inst. Data Summary ....................................................................161 
Hardware Requirements - ECCAIRS 5 Server (Network-accessible)..................................... 161 
Other Pre-Requisites - ECCAIRS 5 Server (Network-accessible) .......................................... 161 
Software Requirements - ECCAIRS 5 Server (Network-accessible) ...................................... 162 
Summary of Options Installed - ECCAIRS 5 Server (Network-accessible) ............................ 163 

7.5. Web Server Inst. Data Summary ............................................................................................167 
Hardware Requirements - ECCAIRS 5 Web Server...............................................................167 
Software Requirements - ECCAIRS 5 Web Server ................................................................168 
Other Pre-Requisites - ECCAIRS 5 Web Server. ...................................................................168 
Summary of Options Installed - ECCAIRS 5 Web Server.......................................................169 
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7.2. CLIENT INST. DATA SUMMARY 
COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

Tick the requirements met and specify details for your specific installation. These may be useful both to 
replicate the installation and for system support. Optional requirements, suitable only to specific 
installation choices or options, are marked with a pale green background. 

Hardware Requirements – ECCAIRS 5 Client 

 H/W REQUIREMENTS ALL MET 

 
 CPU: STANDARD CPU .............................................  

DETAILS ......................................  

 
 RAM: AT LEAST 2 GB RAM.............................................  

DETAILS ......................................  

 
 HD: 10 MB FREE SPACE HD FREE SPACE ........................  

TOTAL HD SIZE ..........................  

Other Pre-Requisites - ECCAIRS 5 Client 

 PRE-REQUISITES ALL MET 

 

 At least one ECCAIRS 5 Server installed, with 
one or more ECCAIRS 5 communication 
protocols (DCOM, Net.TCP, Basic or Ws 
HTTP) enabled, one or more Repositories 
configured. 

 

Software Requirements – ECCAIRS 5 Client 

 S/W REQUIREMENTS ALL MET 

 

 OS: 

 Windows 7 

 Vista 

 Windows XP SP3 

 Windows Server 2008 R2 

 Windows Server 2003 

 32 bit 

 64 bit 

SERVICE PACK .........................  

NOTES ........................................  
.....................................................  
.....................................................  

  .NET 4.0 FULL INSTALLED VERSION ....................................  
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Repository Connection Settings – ECCAIRS 5 Client 

COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

 REPOSITORY NAME..................................................................................................................  

 REPOSITORY ALIAS (if any) ....................................................................................................... 

 ECCAIRS 5 SERVER COMPUTER ............................................................................................. 

 
PROTOCOL TYPE: 

 DCOM 

 DOMAIN/SERVER NAME.............................................  

 NETWORK PASSWORD..............................................  
(only for connection to a remote ECCAIRS 5 Server) 

 

PROTOCOL TYPE: 
 Net.TCP 
 Basic HTTP 
 WS HTTP 
 Basic HTTPS 
 WS HTTPS 

 SERVICE ADDRESS ....................................................  
......................................................................................  

 

 REPOSITORY NAME..................................................................................................................  

 REPOSITORY ALIAS (if any) ....................................................................................................... 

 ECCAIRS 5 SERVER COMPUTER ............................................................................................. 

 
PROTOCOL TYPE: 

 DCOM 

 DOMAIN/SERVER NAME.............................................  

 NETWORK PASSWORD..............................................  
(only for connection to a remote ECCAIRS 5 Server) 

 

PROTOCOL TYPE: 
 Net.TCP 
 Basic HTTP 
 WS HTTP 
 Basic HTTPS 
 WS HTTPS 

 SERVICE ADDRESS ....................................................  
......................................................................................  

 

 REPOSITORY NAME..................................................................................................................  

 REPOSITORY ALIAS (if any) ....................................................................................................... 

 ECCAIRS 5 SERVER COMPUTER ............................................................................................. 

 
PROTOCOL TYPE: 

 DCOM 

 DOMAIN/SERVER NAME.............................................  

 NETWORK PASSWORD..............................................  
(only for connection to a remote ECCAIRS 5 Server) 

 

PROTOCOL TYPE: 
 Net.TCP 
 Basic HTTP 
 WS HTTP 
 Basic HTTPS 
 WS HTTPS 

 SERVICE ADDRESS ....................................................  
......................................................................................  
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7.3. STAND-ALONE SERVER INST. DATA SUMMARY 
COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

Tick the requirements met and specify details for your specific installation. These may be useful both to 
replicate the installation and for system support. Optional requirements, suitable only to specific 
installation choices or options, are marked with a pale green background. 

Hardware Requirements - ECCAIRS 5 Server (Stand-alone) 

 H/W REQUIREMENTS ALL MET 

 
 CPU: STANDARD CPU .............................................  

DETAILS ......................................  

 
 RAM: AT LEAST 2 GB RAM.............................................  

DETAILS ......................................  

 

 HD: 200 MB FREE SPACE for the ECCAIRS 5 
Server, plus possible additional space (see 
options below) 

ECCAIRS 5 SERVER SPACE .....  

HD FREE SPACE ........................  

TOTAL HD SIZE ..........................  

O
P

T
IO

N
 

 HD ADDITIONAL SPACE, if the ECCAIRS 5 
Server host s the Occurrence and/or 
Attachments database. 
Consider: 

 300 kB per Occurrence 

 Suitable Attachments space 

OCCURR. DB SPACE .................  

HD FREE SPACE ........................  

TOTAL HD SIZE ..........................  

NOTES.........................................
.....................................................  

Other Pre-Requisites - ECCAIRS 5 Server (Stand-alone) 

 PRE-REQUISITES 
 

 ORGANISATION ID 
Required for to create Repositories for your 
own Organisation: Ask ECCAIRS Co-ordination 
Centre. 

Note it in the “Summary of Options 
Installed - ECCAIRS 5 Server 
(Stand-alone)” form (see page 159) 
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COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

Tick the requirements met and specify details for your specific installation. These may be useful both to 
replicate the installation and for system support. Optional requirements, suitable only to specific 
installation choices, are marked with pale green. 

Software Requirements - ECCAIRS 5 Server (Stand-alone) 

 S/W REQUIREMENTS ALL MET 

 

 OS: 

 Windows 7 

 Vista 

 Windows XP SP3 

 Windows Server 2008 R2 

 Windows Server 2003 

 32 bit 

 64 bit 

SERVICE PACK ..........................  

NOTES.........................................  
.....................................................  
.....................................................  

  .NET 4 INSTALLED VERSION.....................................  

 
 OCCURRENCE AND ATTACHMENTS 

RDBMS EXISTS, either local or remote 
 LOCAL DATABASE 

 REMOTE DATBASE 

O
P

T
IO

N
  ORACLE DATABASE CLIENT SOFTWARE 

only when the Occurrence and/or Attachment 
databases are hosted in an Oracle RDBMS: 

 32 bit Oracle client with ODAC components 
installed 

NOTES/DETAILS 
.....................................................  
.....................................................  
.....................................................  
.....................................................  

O
P

T
IO

N
 

 LOCAL OCCURRENCE RDBMS (DATABASE 
Server), if the ECCAIRS 5 Server also hosts 
the Occurrence and/or Attachments database. 

 Microsoft SQL Server 2005 and 2008 (both 
express and enterprise versions) 

 Oracle (version 10.2 or greater) 

 Fill the configuration details 
form “Summary of Options 
Installed - ECCAIRS 5 
Server (Stand-alone)”, (see 
page 159) 

O
P

T
IO

N
 

 REMOTE OCCURRENCE AND 
ATTACHMENTS RDBMS (DATABASE 
Server), if the Occurrence and/or Attachments 
database are hosted on another computer. 

 Microsoft SQL Server 2005 and 2008 (both 
express and enterprise versions) 

 Oracle (version 10.2 or greater) 

 Fill the configuration details 
form “Summary of Options 
Installed - ECCAIRS 5 
Server (Stand-alone)”, (see 
page 159)  
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Summary of Options Installed - ECCAIRS 5 Server (Stand-alone) 

COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

Check the options you have installed and specify the corresponding settings used. 

 ECCAIRS 5 
INSTALLATION FOLDER 

 (standard 32 bit Engl.) C:\Program Files\ECCAIRS5 

 (standard 64 bit Engl.) C:\Program Files (x86)\ECCAIRS5

Custom folder .............................................................................. 

 EXTENSIONS INSTALLED EXTENSION (1) ........................................................................... 

Custom inst. Folder ? ................................................................... 

EXTENSION (2) .......................................................................... 

Custom inst. Folder ? ................................................................... 

EXTENSION (3) ........................................................................... 

Custom inst. Folder ? ................................................................... 

 ADD-INS INSTALLED ADD-IN ......................................................................................... 

ADD-IN ......................................................................................... 

 LOCAL  
OCCURRENCE 
DATABASE 

TYPE OF DATABASE.................................................................. 

DATABASE FOLDER................................................................... 

DATABASE NAME....................................................................... 

DATABASE USER/LOGIN ........................................................... 

DATABASE PASSWORD ............................................................ 

DETAILS (e.g. table-space size, etc) ...........................................
.....................................................................................................
..................................................................................................... 

 REMOTE  
OCCURRENCE 
DATABASE 

COMPUTER NAME/ADDR ..........................................................
..................................................................................................... 

TYPE OF DATABASE.................................................................. 

DATABASE FOLDER................................................................... 

DATABASE NAME....................................................................... 

DATABASE USER/LOGIN ........................................................... 

DATABASE PASSWORD ............................................................ 

DETAILS (e.g. table-space size, etc) ...........................................
.....................................................................................................
..................................................................................................... 

 ATTACHMENTS STORED 
IN THE LOCAL 
OCCURRENCE 
DATABASE 

NOTES/DETAILS 
..................................................................................................... 
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 REMOTE ATTACHMENT 
DATABASE 

COMPUTER NAME/ADDR ..........................................................
..................................................................................................... 

TYPE OF DATABASE.................................................................. 

DATABASE FOLDER................................................................... 

DATABASE NAME....................................................................... 

DATABASE USER/LOGIN ........................................................... 

DATABASE PASSWORD ............................................................ 

DETAILS (e.g. table-space size, etc) ...........................................
.....................................................................................................
..................................................................................................... 

 AUTOMATIC BACKUP 
SERVICE 

SETTINGS IN E5ServiceBatchConfiguration.config file 
<Backups> node (see page 116): 

Repository .................................................................................... 

RemoveBackup (true/false).......................................................... 

ForceBackup (true/false ............................................................... 

DirectoryBackup (full directory path) 
..................................................................................................... 

LatencyTime (min) ....................................................................... 

 POSTPONED INDEXING 
SERVICE 

SETTINGS IN E5ServiceBatchConfiguration.config file 
<Postponeds> node (see page 118): 

Repository .................................................................................... 

LatencyTime (min) ....................................................................... 

 ORGANISATION ID 
OBTAINED 
(from the ECCAIRS 
Co-ordination Centre at 
J.R.C.) 

ORGANISATION ID FILE-NAME ................................................. 

FILE STORED IN .........................................................................
..................................................................................................... 

 REPOSITORIES 
INSTALLED 

REPOSITORY 1...........................................................................
..................................................................................................... 

REPOSITORY 2...........................................................................
..................................................................................................... 

REPOSITORY 3...........................................................................
..................................................................................................... 

REPOSITORY 4...........................................................................
..................................................................................................... 

NOTES.........................................................................................
.....................................................................................................
..................................................................................................... 
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7.4. NETWORK-ACCESSIBLE SERVER INST. DATA SUMMARY 
COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

Tick the requirements met and specify details for your specific installation. These may be useful both to 
replicate the installation and for system support. Optional requirements, suitable only to specific 
installation choices or options, are marked with a pale green background. 

Hardware Requirements - ECCAIRS 5 Server (Network-accessible) 

 H/W REQUIREMENTS ALL MET 

 
 CPU: STANDARD, DUAL CORE 

SUGGESTED 
CPU .............................................  

DETAILS ......................................  

 
 RAM: AT LEAST 2 GB RAM.............................................  

DETAILS ......................................  

 

 HD: 200 MB FREE SPACE for the ECCAIRS 5 
Server, plus possible additional space (see 
options below) 

ECCAIRS 5 SERVER SPACE .....  

HD FREE SPACE ........................  

TOTAL HD SIZE ..........................  

O
P

T
IO

N
 

 HD ADDITIONAL SPACE, if the ECCAIRS 5 
Server also hosts the Occurrence and/or 
Attachments database. 

 300 kB per Occurrence 

 Suitable Attachments space 

OCCURR. DB SPACE .................  

HD FREE SPACE ........................  

TOTAL HD SIZE ..........................  

NOTES.........................................
.....................................................  

Other Pre-Requisites - ECCAIRS 5 Server (Network-accessible) 

 PRE-REQUISITES 
 

 ORGANISATION ID 
Required for to create Repositories for your 
own Organisation: Ask ECCAIRS Co-ordination 
Centre. 

Note it in the “Summary of Options 
Installed - ECCAIRS 5 Server 
(Network-accessible)" form (see 
page 163) 
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COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

Tick the requirements met and specify details for your specific installation. These may be useful both to 
replicate the installation and for system support. Optional requirements, suitable only to specific 
installation choices or options, are marked with a pale green background. 

Software Requirements - ECCAIRS 5 Server (Network-accessible) 

 S/W REQUIREMENTS ALL MET 

 

 OS: 

 Windows 7 

 Vista 

 Windows XP SP3 

 Windows Server 2008 R2 

 Windows Server 2003 

 32 bit 

 64 bit 

SERVICE PACK .........................  

NOTES ........................................  
.....................................................  
.....................................................  

  .NET 4.0 FULL INSTALLED MY VERSION ..............................  

O
P

T
IO

N
 

 IIS 6 or IIS 7 INSTALLED AND CONFIGURED
only if remote clients use Web Services (Basic 
HTTP / Ws HTTP) to connect to this ECCAIRS 
5 Server. 

 IIS 6 

 IIS 7 

 Fill the configuration details 
form “Summary of Options 
Installed - ECCAIRS 5 
Server (Network-
accessible)”, (see page 163) 

 
 OCCURRENCE AND ATTACHMENTS 

RDBMS EXISTS, either local or remote 
 LOCAL DATABASE 

 REMOTE DATBASE 

O
P

T
IO

N
 

 REMOTE OCCURRENCE AND 
ATTACHMENTS RDBMS (DATABASE 
Server), if the Occurrence and/or Attachments 
database are hosted on another computer.  

 Microsoft SQL Server 2005 and 2008 (both 
express and enterprise versions) 

 Oracle (version 10.2 or greater) 

 Fill the configuration details 
form “Summary of Options 
Installed - ECCAIRS 5 
Server (Network-
accessible)”, (see page 163) 

 

O
P

T
IO

N
 

 LOCAL OCCURRENCE RDBMS (DATABASE 
Server), if the ECCAIRS 5 Server also hosts 
the Occurrence and/or Attachments database.  

 Microsoft SQL Server 2005 and 2008 (both 
express and enterprise versions) 

 Oracle (version 10.2 or greater) 

 Fill the configuration details 
form “Summary of Options 
Installed - ECCAIRS 5 
Server (Network-
accessible)”, (see page 163) 

O
P

T
IO

N
  ORACLE DATABASE CLIENT SOFTWARE 

only when the Occurrence and/or Attachment 
databases are hosted in an Oracle RDBMS: 

 32 bit Oracle client with ODAC components 
installed 

NOTES/DETAILS 
.....................................................  
.....................................................  
.....................................................  
.....................................................  
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Summary of Options Installed - ECCAIRS 5 Server (Network-accessible) 

COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

Check the options you have installed and specify the corresponding settings used. 

 ECCAIRS 5 
INSTALLATION FOLDER 

 (standard 32 bit Engl.) C:\Program Files\ECCAIRS5 

 (standard 64 bit Engl.) C:\Program Files (x86)\ECCAIRS5

Custom folder .............................................................................. 

 EXTENSIONS INSTALLED EXTENSION (1) ........................................................................... 

Custom inst. Folder ? ................................................................... 

EXTENSION (2) .......................................................................... 

Custom inst. Folder ? ................................................................... 

EXTENSION (3) ........................................................................... 

Custom inst. Folder ? ................................................................... 

 ADD-INS INSTALLED ADD-IN ......................................................................................... 

ADD-IN ......................................................................................... 

 DCOM  
CLIENT NETWORK 
ACCESS  

E5Administrator password ...........................................................
..................................................................................................... 

Firewall rule name set for: 

DCOM Port (suggested ECCAIRS DCOM Port) 
..................................................................................................... 

E5RSServer.exe (suggested ECCAIRS Programs) 
..................................................................................................... 

 DCOM  
CLIENT NETWORK 
ACCESS  

E5Administrator password ...........................................................
..................................................................................................... 

 Net.TCP  
CLIENT NETWORK 
ACCESS  

TCP_PORT (default 8735) .......................................................... 

SERVER_ADDRESS (Server IP address and/or fully qualified 
Internet name, e.g. myserver.myorg.com) 
..................................................................................................... 

Net.TCP REPOSITORY SERVER ACCESS ADDRESS (used 
by Client applications) 
.....................................................................................................
( net.tcp://SERVER_ADDRESS:8735//ECCAIRS5/netTcp ), 
unless customised (see page 70). 

 Ws HTTP / Basic HTTP 
NETWORK ACCESS  
(via Windows service) 

HTTP_TCP_PORT (default 8731) ............................................... 

SERVER_ADDRESS (Server IP address and/or fully qualified 
Internet name, e.g. myserver.myorg.com) 
..................................................................................................... 
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Ws-HTTP REPOSITORY SERVER ACCESS ADDRESS 
(used by Client applications) 
.....................................................................................................
(http://SERVER_ADDRESS:8731//ECCAIRS5/ws),  
unless customised (see page 70). 

Basic-HTTP REPOSITORY SERVER ACCESS ADDRESS 
(used by Client applications) 
.....................................................................................................
( http://SERVER_ADDRESS:8731//ECCAIRS5/basic ), 
unless customised (see page 70). 

 Ws HTTP / Basic HTTP 
NETWORK ACCESS  
(via IIS) 

ALIAS for virtual directory (eccairs5 suggested) 
..................................................................................................... 

SERVER_ADDRESS (Server IP address and/or fully qualified 
Internet name, e.g. myserver.myorg.com) 
..................................................................................................... 

AS SET IN LINE 
<add baseAddress ="http://SERVER_ADDRESS/ALIAS"/> 
line within the web.config file (see page 80). 

Basic and Ws-HTTP WEB SERVER ACCESS ADDRESSES  
(used by Client applications) 
Ws-HTTP .....................................................................................
Basic-HTTP ................................................................................. 

 Ws HTTPS / Basic HTTPS 
NETWORK ACCESS  
(via IIS) 

ALIAS for virtual directory (eccairs5 suggested) 
..................................................................................................... 

SERVER_ADDRESS (Server IP address and/or fully qualified 
Internet name, e.g. myserver.myorg.com) 
..................................................................................................... 

AS SET IN LINE 
<add baseAddress ="http://SERVER_ADDRESS/ALIAS"/> 
line within the web.config file (see page 80). 

Basic and Ws-HTTPS WEB SERVER ACCESS ADDRESSES  
(used by Client applications) 
Ws-HTTPS ..................................................................................
Basic-HTTPS ............................................................................... 

 LOCAL  
OCCURRENCE 
DATABASE 

TYPE OF DATABASE.................................................................. 

DATABASE FOLDER................................................................... 

DATABASE NAME....................................................................... 

DATABASE USER/LOGIN ........................................................... 

DATABASE PASSWORD ............................................................ 

DETAILS (e.g. table-space size, etc) ...........................................
.....................................................................................................
..................................................................................................... 

 REMOTE  
OCCURRENCE 
DATABASE 

COMPUTER NAME/ADDR ..........................................................
..................................................................................................... 
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TYPE OF DATABASE.................................................................. 

DATABASE FOLDER................................................................... 

DATABASE NAME....................................................................... 

DATABASE USER/LOGIN ........................................................... 

DATABASE PASSWORD ............................................................ 

DETAILS (e.g. table-space size, etc) ...........................................
.....................................................................................................
..................................................................................................... 

 ATTACHMENTS STORED 
IN THE LOCAL 
OCCURRENCE 
DATABASE 

NOTES/DETAILS 
..................................................................................................... 

 REMOTE  
ATTACHMENT 
DATABASE  

COMPUTER NAME/ADDR ..........................................................
..................................................................................................... 

TYPE OF DATABASE.................................................................. 

DATABASE FOLDER................................................................... 

DATABASE NAME....................................................................... 

DATABASE USER/LOGIN ........................................................... 

DATABASE PASSWORD ............................................................ 

DETAILS (e.g. table-space size, etc) ...........................................
..................................................................................................... 

 AUTOMATIC BACKUP 
SERVICE 

SETTINGS IN E5ServiceBatchConfiguration.config file 
<Backups> node (see page 116): 

Repository .................................................................................... 

RemoveBackup (true/false).......................................................... 

ForceBackup (true/false ............................................................... 

DirectoryBackup (full directory path) 
..................................................................................................... 

LatencyTime (min) ....................................................................... 

 POSTPONED INDEXING 
SERVICE 

SETTINGS IN E5ServiceBatchConfiguration.config file 
<Postponeds> node (see page 118): 

Repository .................................................................................... 

LatencyTime (min) ....................................................................... 

 ORGANISATION ID 
OBTAINED 

ORGANISATION ID FILE-NAME ................................................. 

FILE STORED IN ......................................................................... 

 REPOSITORIES 
INSTALLED 

REPOSITORY 1...........................................................................
..................................................................................................... 

REPOSITORY 2...........................................................................
..................................................................................................... 
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REPOSITORY 3...........................................................................
..................................................................................................... 

REPOSITORY 4...........................................................................
..................................................................................................... 

NOTES.........................................................................................
.....................................................................................................
..................................................................................................... 
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7.5. WEB SERVER INST. DATA SUMMARY 
COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

Tick the requirements met and specify details for your specific installation. These may be useful both to 
replicate the installation and for system support. Optional requirements, suitable only to specific 
installation choices or options, are marked with a pale green background. 

Hardware Requirements - ECCAIRS 5 Web Server 

 H/W REQUIREMENTS ALL MET 

 
 CPU: DUAL CORE OR BETTER CPU .............................................  

DETAILS ......................................  

 
 RAM: 4 GB (min 2GB + 50 MB per concurrent 

User connection) 
RAM.............................................  

DETAILS ......................................  

 

 HD: 300 MB FREE SPACE  
(for the ECCAIRS 5 Server, the IIS Web 
Server) 

ECCAIRS 5 OWN SPACE ...........  

HD FREE SPACE ........................  

TOTAL HD SIZE ..........................  

O
P

T
IO

N
 

 HD ADDITIONAL SPACE FOR 
OCCURRENCE DATBASE, if the ECCAIRS 5 
Server also hosts the Occurrence and/or 
Attachments database. 

 300 kB per Occurrence 

 Suitable Attachments space 

OCCURR. DB SPACE .................  

HD FREE SPACE ........................  

TOTAL HD SIZE ..........................  

NOTES.........................................
.....................................................  

 

O
P

T
IO

N
 

 HD ADDITIONAL SPACE FOR WEB USERS 
DATABASE, if the ECCAIRS 5 Web Server 
computer also hosts the database used for the 
Web Server itself to store the Web submitted 
User Queries. 

 Minimum 100 MB 

 Then space proportional to the number of 
concurrent users: 

o Suppose 50 Query per Web User 

o 50 kB per Query 

o 50 MB for logging 

WEB DB SPACE..........................  

HD FREE SPACE ........................  

TOTAL HD SIZE ..........................  

NOTES/DETAILS 
.....................................................  
.....................................................  
.....................................................  
.....................................................
.....................................................  
.....................................................  
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COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

Tick the requirements met and specify details for your specific installation. These may be useful both to 
replicate the installation and for system support. Optional requirements, suitable only to specific 
installation choices or options, are marked with a pale green background. 

Software Requirements - ECCAIRS 5 Web Server 

 S/W REQUIREMENTS ALL MET 

 

 OS: 

 Windows 7 

 Vista 

 Windows XP SP3 

 Windows Server 2008 R2 

 Windows Server 2003 

OS................................................  

 32 bit 

 64 bit 

SERVICE PACK ..........................  

NOTES.........................................  

  IIS 6 or IIS 7 INSTALLED IIS VERSION ...............................  

  .NET 4.0 FULL INSTALLED VERSION.....................................  

O
P

T
IO

N
  ORACLE DATABASE CLIENT SOFTWARE 

only when the ECCAIRS 5 Web database is 
hosted in an Oracle RDBMS: 

 32 bit Oracle client with ODAC components 
installed 

NOTES/DETAILS 
.....................................................  
.....................................................  
.....................................................  
.....................................................  

 

Other Pre-Requisites - ECCAIRS 5 Web Server. 

 PRE- REQUISITES ALL MET 

 

 ECCAIRS 5 SERVER INSTALLED AND 
CONFIGURED, either local on the same 
computer or remote on a network-accessible 
computer. 

 If the ECCAIRS 5 Server is installed on the 
same computer then you must also check all 
the requirements for a Standalone ECCAIRS 5 
Server  
See page 56, Section "3.2 Requirements 
(Stand-alone Server) ". 

 LOCAL ECCAIRS 5 
SERVER 

 REMOTE ECCAIRS 5 
SERVER  

 

 WEB RDBMS (DATABASE Server) 
INSTALLED either local on the same computer 
or remote on a network-accessible computer. 

 Microsoft SQL Server 2005 and 2008 (both 
express and enterprise versions) 

 Oracle (version 10.2 or greater) 

 LOCAL WEB DATABASE 

 REMOTE WEB DATABASE 
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Summary of Options Installed - ECCAIRS 5 Web Server 

COMPUTER NAME______________________________________________________________  

COMPUTER LOCATION _________________________________________________________  

Check the options you have installed and specify the corresponding settings used. 

 ECCAIRS 5 
INSTALLATION FOLDER 

 (standard 32 bit Engl.) C:\Program Files\ECCAIRS5 

 (standard 64 bit Engl.) C:\Program Files (x86)\ECCAIRS5

Custom folder .............................................................................. 

 ECCAIRS 5 WEB 
INSTALLATION FOLDER 

 C:\E5WebSite 

Custom Web folder ...................................................................... 

 LOCAL ECCAIRS 5 
SERVER CONFIGURED 
(when using the WEB 
SERVER with the 
ECCAIRS 5 SERVER 
automatically installed on 
the same computer)  

Follow the Server Setup Section (see page 15 and page 51), 
then 
PRINT AND FILL IN THE CORRESPONDING FORM: 

 (if your Local ECCAIRS 5 Server is Self-standing): 
“Summary of Options Installed - ECCAIRS 5 Server 
(Stand-alone)”, within Chapter 1.1 (see page 159). 

 (if your Local ECCAIRS 5 Server is Network-accessible) 
“Summary of Options Installed - ECCAIRS 5 Server 
(Network-accessible)”, within Chapter 1.1 (see page 
163). 

 BASIC WEB 
AUTHENTICATION 
(STANDARD CHOICE) 

VIRTUAL DIRECTORY (ALIAS) DEFINED ................................. 

PHYSICAL PATH TO VIRTUAL DIRECTORY.............................
..................................................................................................... 

RESULTING URL......................................................................... 

 WEB AUTHENTICATION 
BASED ON WINDOWS 
USERS (OPTION) 

VIRTUAL DIRECTORY (ALIAS) DEFINED ................................. 

RESULTING URL......................................................................... 

 WEB SERVER CORE 
SETUP  

E5WebAdministrator password ....................................................
..................................................................................................... 

 LOCAL WEB SERVER 
DATABASE 

TYPE OF DATABASE.................................................................. 

DATABASE FOLDER................................................................... 

DATABASE NAME....................................................................... 

DATABASE USER/LOGIN ........................................................... 

DATABASE PASSWORD ............................................................ 

DETAILS (e.g. table-space size, etc) ...........................................
.....................................................................................................
..................................................................................................... 
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 REMOTE WEB SERVER 
DATABASE 

COMPUTER NAME/ADDR ..........................................................
..................................................................................................... 

TYPE OF DATABASE.................................................................. 

DATABASE FOLDER................................................................... 

DATABASE NAME....................................................................... 

DATABASE USER/LOGIN ........................................................... 

DATABASE PASSWORD ............................................................ 

DETAILS (e.g. table-space size, etc) ...........................................
.....................................................................................................
..................................................................................................... 

 WEB CONFIGURATION 
MANAGER  

MAXIMUM ALLOWED USERS .................................................... 

SERVER APPLICATIONS LIMIT ................................................. 

SESSIONS PER APPLICATION LIMIT........................................ 

SERVER TYPE: 

 DEDICATED SERVER (DEFAULT) 

 SHARED SERVER 

OTHER DETAILS.........................................................................
 
REPOSITORIES LINKED (FILL NEXT ROWS IN THIS TABLE) 

 LOCAL ECCAIRS 5 
SERVER WEB-ENABLED 
REPOSITORIES (when 
using the WEB SERVER 
with the ECCAIRS 5 
SERVER automatically 
installed on the same 
computer) 

REPOSITORY 1...........................................................................
..................................................................................................... 

REPOSITORY 2...........................................................................
..................................................................................................... 

REPOSITORY 3...........................................................................
..................................................................................................... 

REPOSITORY 4...........................................................................
..................................................................................................... 

OTHERS/NOTES .........................................................................
..................................................................................................... 
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 REMOTE ECCAIRS 5 
SERVER WEB-ENABLED 
REPOSITORIES (when 
using the WEB SERVER 
with ECCAIRS 5 SERVERS 
on other Computers) 

NOTES/DETAILS ......................................................................... 

REPOSITORY 1........................................................................... 
 DCOM - DOMAIN/SEVER NAME ....................................

NETWORK PASSWORD ................................................. 
 WEB SERVICE - SERVICE ADDR 

.......................................................................................... 
 Net.TCP     

 Basic HTTP     WS HTTP 

 Basic HTTPS     WS HTTPS 

REPOSITORY 2........................................................................... 
 DCOM - DOMAIN/SEVER NAME ....................................

NETWORK PASSWORD ................................................. 
 WEB SERVICE - SERVICE ADDR 

.......................................................................................... 
 Net.TCP 

 Basic HTTP     WS HTTP 

 Basic HTTPS     WS HTTPS 

REPOSITORY 3........................................................................... 
 DCOM - DOMAIN/SEVER NAME ....................................

NETWORK PASSWORD ................................................. 
 WEB SERVICE - SERVICE ADDR 

.......................................................................................... 
 Net.TCP     

 Basic HTTP     WS HTTP 

 Basic HTTPS     WS HTTPS 
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